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Chapter 1: Introduction

Welcome to Time Guardian, the all in one, easy to use Time and Attendance system. Time
Guardian allows you to track and manage your employees’ time and attendance directly from
your PC and makes the collecting, reporting and the transferring of employees’ hours to payroll
companies easier and quicker than ever before.

If this is your first time working with a time and attendance package, there may be terms that
are new to you such as Salary, Hourly, Pay Policy, Pay Code, Wages, Unit and Point. A
detailed Glossary, located in the back of this User Guide, has been provided to assist you as
you navigate through Time Guardian.

Should you have any comments on Time Guardian and the materials provided we ask that you
e-mail them to TimeGuardian@amano.com. All feedback is welcome and greatly appreciated,
and will help us provide a better product to you, our customer.

We thank you for selecting Time Guardian and welcome you to the Amano Cincinnati family of
Time Solution products.

Features and Requirements

Features

e Standard one hundred (100) Employee Capacity (not including inactive employees), with
available upgrade to a 250 employee capacity maximum.

e Eleven (11) Built-In Payroll Interfaces, with full QuickBooks integration.
e Unlimited Number of Schedules.
e Unlimited Number of Departments.

e Time Rounding Capability Based on Company-Defined Pay Policies (Customizable
Rounding).

¢ Nine (9) Predefined Pay Codes for Hours Allocation with Pay Code Multipliers.
e Rates for Wages calculation.

e Two (2) Pay Codes for Tips and Bonuses.

¢ Nine (9) Predefined Exception Flags for Employee Punch Tracking.

¢ Nine (9) On Demand Reports.

e Automatic Backup of Database Files.

e Automatic Polling of Data Collection Terminal.

e Door Access and Bell Schedule Capabilities.

¢ Flash Filer Database to Reduce Program Conflicts, Minimize Space Requirements and
Increase Speed.

e Several Built-In Utilities for Maintenance of the System.

e Extensive On-Line Help.
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Requirements

e Windows 2000/NT/ME/XP/Vista.

e One Available USB Port.

e CD-ROM Dirive.

e 32 MB of RAM (64 MB preferred).

e 100 MB of Free Hard Disk Space.

e Screen Display 1024 x 768 small font.
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Chapter 2: General Installation Guidelines

1.
2.
3.

Refer to the Software Installation Manual (AMX-40090X).
Install the terminal first, using the appropriate installation guide.

Install the Time Guardian software.

Time Guardian Software Installation

There are three documents available to assist you in the use and setup of Time Guardian: This
Time Guardian User’s Guide, the Basic and Advanced Wizard Worksheets, and the Software
Installation Manual. These documents can be printed from the Time Guardian Welcome screen
that appears after the software installation is complete. They are also located in the Time
Guardian/Documentation/Software folder. For a complete description of the Time Guardian
installation see the "Software Installation Manual". An overview of the installation steps is as
follows:

1.

Insert the Time Guardian CD into your CD-ROM drive, and Time Guardian will automatically
launch the Installshield™ Wizard.

When asked for your Time Guardian Serial Number, it can be found on a label on the
outside of your Time Guardian box.

When asked if you would like the installation to create a Desktop icon for your Time
Guardian system, it is recommended that you select “Yes.” Desktop icons can be added
later by creating a new shortcut to the Timeguardian.exe file, located in the Time Guardian
program folder.

When Time Guardian initially begins, the following screen will prompt the user to select
Basic or Advanced Setup selection:

There are three options: Next, Cancel, and Print. Before proceeding, it is recommended to
print the appropriate worksheet by pressing the Print button.

Time Guardian, by default will install to support 100 employees. If you have more than 100
employees, select Upgrade Time Guardian from the File Menu, follow the instructions to
obtain an upgrade (access number) for 250 employees.

Note: If employee capacity above 250 is needed, call Amano Cincinnati Inc. or your Amano

dealer for information on upgrading to Time Guardian Pro, which offers unlimited
employee capacity.
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Time Guardian Wizards

The Time Guardian Basic and Advanced Setup Wizards will allow you to perform a seamless
basic or advanced setup when used with the appropriate Wizard on-line help and Wizard
Worksheet. The Basic Setup Wizard is designed for a 3-step rapid installation and configuration
of an easy-to-use time and attendance system. While the Advanced Setup Wizard is designed
as a 9-step process to configure a more complex time and attendance system with detailed pay
policy rules.

The three (3) steps of the Basic Setup Wizard are:
STEP 1: General Setup
o Company Name — must define
e Payroll Interface
e Time Format
e Hours Display
STEP 2: Pay Policy Setup — must define at least one (1) pay policy
STEP 3: Login Setup — must create an administrator profile

The nine (9) steps of the Advanced Setup Wizard are:
STEP 1: General Setup
e Company Profile
e Payroll Interface
e Time Format
e Hours Display
STEP 2: Department Setup
STEP 3: Pay Policy Setup
e Overtime Authorization
e Pay Code Type
e Overtime Rules
¢ Rounding Rules
e Meal Rules
e Advanced Overtime
STEP 4: Pay Code Setup
e Pay Code Types
e Overtime and Absence Rules
e Wages Rules
STEP 5: Exception Setup
STEP 6: Schedule Setup
STEP 7: Employee Setup
STEP 8: Clock Setup
STEP 9: Login Setup — must create an administrator profile
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The Finish :l button will only be active when all of the required information is provided. If
you have missed one of these fields, the “Finish” icon will be grayed out and you must go back
and complete the missing information. Once the initial setup is complete, The Wizard can be
used to make modifications to your setup. For instructions on how to do this, please refer to the
section about Using the Wizard.

Time Guardian Wizard Worksheets

The Time Guardian Basic and Advanced Worksheets provide you with a place to record your
company information and rules prior to starting the Basic or Advanced setup Wizards. Should
you find it necessary to make changes to your system, we encourage you to note them on the
Worksheet for future reference.

Time Guardian Registration

Please return the enclosed warranty registration card or Register Product from Customer
Service online at:

http://www.amano.com

Time Guardian Basic Customer Support

On-Line Help

Can be accessed through the main menu in the software and is searchable by topic. See QS 7:
Printing Time Guardian Documentation for more detailed help information.

E-Mail Support

Support is provided via e-mail at TGSupport@amano.com. A zip file with your settings should
be sent to Time Guardian support to resolve any problems.

Time Guardian One-on-One Technical Support Options

Toll Free support number is: 1(800) 253-9836.

e The first 30 days of support is provided free of charge, however this only applies to
installation and set up questions, and requires the user complete the warranty registration
card.

o After 30 days, users requiring phone support will be charged a fee per incident or the user
can purchase a support contract.

e A Support Contract (contact support for fee) includes hardware and software support for
one year and also includes free software updates.
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Software Upgrades

e With Time Guardian, you can purchase an upgrade access number to expand the employee
capacity from 100 to 250 employees via the Toll Free support number.

¢ Should you require a product with more than 250 employees, you can expand your system
to an unlimited capacity with Time Guardian Pro.

e Time Guardian Pro protects your initial investment in Time Guardian, as terminals,
databases, and employee information created in Time Guardian is compatible with Time
Guardian Pro.

e Please contact Amano at our Toll Free number above to provide you with one of our
Authorized Time Guardian Pro dealers in your area.

Time Guardian User’'s Guide

The Time Guardian User’'s Guide was designed to assist you in the daily operation of your
system and to provide you with a comprehensive understanding of the software. The User’s
Guide has a complete Glossary with vocabulary for easy word reference and an index to locate
specific areas of interest.

If you are not connected to an E-mail server or do not know the information required (zip file),
please contact your computer support person. This is not a feature that is supported by Time
Guardian Support. If no access is available, upload the SupportData.zip file (located in the
TEMP directory in the Time Guardian folder) to our ftp site at ftp.amano.com and place it in the
Time Guardian/Support/Incoming folder.

Time Guardian Hardware

Please refer to the information provided in the original packaging for hardware warranty
information. Each clock comes with a one year limited warranty from the date of purchase. For
additional information, please e-mail TGSupport@amano.com.
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Chapter 3: Working with Time Guardian

Recording Punches at the Terminal (Punching In and Out)

One of the main reasons for purchasing a time and attendance system is to accurately track the
hours worked by an employee and present this information to managers, payroll personnel and
the employees themselves.

In order to gather this information, employees must be trained to use the terminal. Rules
governing the use of the terminal will vary from company to company, however, it is important to
get all employees in the habit of punching the clock at the start and end of their workday, and for
meals (if required). Time Guardian comes with 25 pre-numbered employee badges that can be
assigned to employees. Once the clock is plugged in and wired, simply swipe the card through
the reader and wait for the confirmation beep. If an employee’s card is unable to be read by the
terminal due to damage, replacement cards can be ordered by contacting our Parts Center at 1-
800-253-9836. An employee’s badge number can be changed if the badge is lost or damaged.
In this instance, the Employee Number will remain the same to ensure the historical accuracy of
the employee’s records.

One-Minute Swipe Rule

To prevent duplicate punches from being recorded, the Time Guardian MTX-15 terminal comes
with a built-in “One Minute Rule”. This feature prevents the terminal from recording more than
one punch per employee, per minute. If the employee attempts to punch twice during the same
minute, they will receive two beeps indicating that the punch has not been accepted. Once the
one-minute time interval has passed, the employee’s punch will be accepted.

Time Guardian Layout

The following screenshot displays the default main view of Time Guardian and identifies its
various sections. This view can be modified based on the selection made in the Display menu.
The Status Bar at the top of the screen contains the software name, the active employee name
and the screen icons that will allow you to minimize, resize or close the software.
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Main Dropdown Menus

File Menu

The “File” menu allows you to create custom toolbar settings, refresh data, backup data, print
reports, and exit the application. Click on File from the main Time Guardian screen view and
the following dropdown menu will appear:

Emplovee  Display o

Custom Toolbar

Refresh Data »
Backup »
Upgrade Time Guardian
Prink

Exit

Descriptions of the File submenu functions follow:

e Custom Toolbar: Can be used to customize the Time Guardian toolbar by adding or
removing buttons.

o Refresh Data: Updates information for the currently selected employee or all the
employees currently being displayed in the employee list box.

¢ Backup: This has the following two submenu choices:

a. Run Backup: Creates a backup file on demand.

b. Setup Backup: This allows you to configure an automatic backup.
e Upgrade Time Guardian: Allows you to upgrade from a capacity of 100 to 250 employees.
e Print: Used to print Time Guardian Reports.

o Exit: Used to exit the Time Guardian application.

Employee Menu

The “Employee” menu allows you to add an employee or select an employee. Click on
Employee from the main Time Guardian screen view and the first dropdown menu will appear.
If the QuickBooks Payroll Interface has been selected (see Payroll Interface Creation).

Add Emplovee
Select Employees

Descriptions of the Employee submenu functions follow:

o Add Employee: this option allows you to add a new employee to your Time Guardian
system.

e Select Employees: this option allows you to limit the employees being seen in the
Employee List box based on selections made on the Department or All Employees filter.
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o Sync Employee(s) with Payroll: If QuickBooks is installed on the local PC and the
QuickBooks application is running, this option synchronizes the selected employee(s) Time
Guardian information with QuickBooks.

Display Menu

The “Display” menu allows you to select how you want information presented to you on the
main screen. Click on Display from the main Time Guardian screen view and the following

dropdown menu will appear:
|IMH gc:::mmunicatinn

Repart or Payrol
Hours Grid
v Both

Descriptions of the Display submenu functions follow:

e Report or Payroll: Selecting this option will hide the Hours Grid and maximize the view of
the Report or Payroll being displayed.

o Hours Grid: Selecting this option will hide the Report or Payroll section in the main view and
maximize the view of the Hours Grid.

o Both: This is the default setting and it displays both the Hours and Report information in the
main view.

Communication Menu

The Communication menu is used to remotely perform functions on active terminals from the
Host PC. It is divided into two groups, those functions distinct to Time Guardian terminals and
for polling and downloading to the MTX-15 Time Guardian, Fingerprint, and HandPunch (HP)
terminals. For more information on an HandPunch Terminal purchase, call or email Time
Guardian support. Click on Communication from the main Time Guardian menu bar and the
following dropdown menu will appear:

The MTX submenu selection allows you to perform the following operations on all active Time
Guardian terminals. Click on MTX submenu from the Communication menu and the following
pop up menu will appear:

Descriptions of the Communication/MTX submenu functions follow:

e Auto Update: Confirms that the clock and the Host PC are communicating, assigns a
terminal number and the Daylight Saving Time settings to the terminal including Door
Access and Bell Schedule. This action will also set the time display of the terminal as
determined by the PC settings.
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o Initialize: This function will reset the terminal back to factory settings and clear the memory.
You should wait one minute between performing this operation and punching at the
terminal. After performing Initialize function, you will have to perform Auto Update function
again.

o Memory Dump: Uploads all the punch data currently at the terminal to the PC and resets
the memory pointer to the start. This function is useful should there be a catastrophic data
loss. If this function is performed with active data, duplicate punches may be created.

o Clear Transaction: This will clear the entire memory of the terminal and reinitialize it to
factory settings.

The Poll/Download submenu selection allows you to perform the following operations on all
active MTX Time Guardian, Fingerprint, and HandPunch terminals. Click on Poll/Download
submenu from the Communication menu and the following pop up menu will appear:

Descriptions of the Communications/MTX, Fingerprint, and HandPunch functions follow:

o Polling: This operation collects the most recent data from the terminal. When checked,
Time Sync. performs time synchronization between the Host PC and the terminal including
Daylight Saving settings.

o Downloading: Sends Daylight Saving Time (DST) settings, employee assignments and
Bell and Door Schedules to the terminal.
Setup Menu

The “Setup” menu provides guick access to five modules, which are: the Login Profiles, Pay
Policy ,Schedule setup, Terminal Setup, and Wizard. Click on Setup from the main Time
Guardian menu bar and the following dropdown menu will appear:

Descriptions of the Setup submenu functions follow:

o Login Profiles: This option allows you to add, modify and delete administrator, user profiles
for Time Guardian.

o Pay Policy: This option allows you to add, modify and delete pay policies for Time
Guardian. For more information, refer to: Using the Wizard.

e Schedule Setup: Allows you to add, edit of delete Employee Schedules. For more
information see Schedule Tab (Schedule Administration).

e Terminal Setup: Enables Time Guardian to communicate with your terminal(s). This is
where you can configure terminals and/or locations. For more information see Clock Tab
(Communication Settings).
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o Wizard: Basic: Contains three (3) tabs, including: General, Pay Policy, and Login. The
Wizard is the only place that changes can be made. For more information see the section
about Using the Wizard.

Advanced: Contains nine (9) tabs, including: General, Department, Pay Policy, Pay Code,
Exception, Schedule, Employee, Clock, and Login. The Wizard is the only place that
changes can be made to Pay Policy, Pay Code, Exceptions Tracking, Payroll Setup, and
Time and Hours Display format. For more information see the section about Using the
Wizard.

Grid Display Menu

The “Grid Display” menu allows you to select the way that punch information is presented in the
“IN” and “OUT” columns of the employee data field. Click on Grid Display from the main Time
Guardian menu bar and the following dropdown menu will appear:

By Punched Time

v By Rounded Time

Descriptions of the Grid Display submenu functions follow:

e By Punched Time: Displays the employee’s actual punch as recorded at the terminal.

¢ By Rounded Time: Displays the employee’s time using the rounding rules of the Pay Policy
that the employee is assigned to.

Help Menu

The “Help” menu provides several options that will assist you in your use of the Time Guardian
software. Click on Help from the main Time Guardian menu bar and the following dropdown
menu will appear:

Descriptions of the Help submenu functions follow:

o Help F1: Selecting this option will provide access to the entire User’'s Guide, with searching
capabilities for better navigation. See the section about QS 9: Using On-line Help of this
guide for more detailed Help information.

e Tools: Time Guardian comes with two built-in tools to assist you in the calculation functions.
These tools are Time Simulation and Hours Simulation. For further information on both of
these options see the section about Troubleshooting Calculations of this guide.

e About: This selection will provide you with the version of Time Guardian that you are
currently using. This information is required when placing a support call.
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e Support: This selection will automatically create a zipped backup of your data and allow
you to send it directly to Time Guardian Support. For more information see the section
about General Installation Guidelines, and the section Time Guardian Basic Customer
Support in this Guide.

o XML Data: this selection will export payroll information for selected employees into a XML
file.

o WorkSheet: This selection will launch Adobe Acrobat and the appropriate PDF WorkSheet
file (Basic or Advanced).

e User Guide: This selection will launch Adobe Acrobat and the PDF User Guide file.

Custom Toolbar

Time Guardian’s Custom Toolbar is located below the Main Menu. This toolbar can be
customized according to your personal preferences by selecting the “Custom Toolbar” option
from the “File” menu (see the following figure). Once open, you have the option to add and
delete icons by dragging and dropping your selection to and from the toolbar. Select “OK” to
save your settings.

The following figure displays the default icon “Select Employee” on the far left, which is used to
filter the employees displayed in the Employee List. The figure also displays all the other
options available for the toolbar, which are: Communications (Polling and Downloading), Setup
(Wizard), Help (Help Menu) and Reports (Print Icon). For detailed instructions on creating a
Custom Toolbar, please refer to the section about QS 1: Creating a Custom Toolbar.
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Report and Payroll Toolbars

Depending on what is active in the Report/Payroll View, one of the following toolbars will be
displayed to the right of the “Custom Toolbar.” When this area is blank, no report or payroll is
active. Below is a detailed description of the each of these toolbars.

Report Sizing and Scrolling Toolbars

The following icons will only be active when a report is being displayed in the Report/Payroll
view and are helpful when viewing a report with multiple employees. The plus and minus
magnifying glasses allow you to increase and decrease the view of a report from 1 — 11, the
default view (size) is 5. The scroll arrows allow you to move from employee to employee. The
icons will appear alongside the custom toolbar as:

el [ w

The following is a description of these icons seen above, from left to right:

e Enlarge: Selecting the magnifying glass with the Plus sign will maximize the view of the
current report.

o Decrease: Selecting the magnifying glass with the Minus sign will return the view of the
current report to the default setting.

o Left Red Arrow: Selecting this icon will take you to the first record of the current report.
o Left Yellow Arrow: Selecting this icon will take you back one record in the current report.
¢ Right Yellow Arrow: Selecting this icon will take you forward one record in the current report.

e Right Red Arrow: Selecting this icon will take you to the last record of the current report.

Payroll Interface Toolbar

The following icons will only be active when a payroll file is being displayed in the
Report/Payroll view. They are, from left to right:

[
e Save Payroll Settings: The Save Payroll Settings icon saves all data entry made for

the selected payroll company.

e Run Payroll: The Run Payroll é icon creates the export file for the active pay period.
This file will be saved to the directory indicated in the payroll settings.

o Payroll Pages: The Payroll Pages Sfeofs > icons allow you to navigate through each
of the payroll settings. For example, the following are four pages of payroll settings for
QuickBooks interface:
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Page 1 of 4

Upon clicking "QuickBooks hours integration”, the following will appear:

Page 2 of 4

Page 3 of 4

Page 4 of 4
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Grid Display Toolbar

Time Guardian allows you to change the data displayed in the Report/Payroll view, Hours Grid,
and the Employee Totals. This two-part view displays the date range of the pay period currently
being displayed and its relative pay period. Use the red arrows to advance or scroll backward
through the data.

i’ IPrevious Pay Periad i

ISun 3242002 - Sat 343042002

£
You can also left mouse click on the Current Pay Period arrow button .21 to open the Pay

Period Selection menu as illustrated below. This menu will allow you to choose the direction
(before, after, previous, current) and number of pay periods to move the Current Pay Period

date.

E
Current pay Period
ISun 3/24/2002 - Sat 3/30/2002
Mumber of pay periods I‘I vl
FPay period
' Befare " Previous
O After " Current
X Cancel |

Reports and Payroll List

Located to the left of the Main view, the Reports and Payroll List box displays icons of the nine
reports available, and the Payroll Interface icon. To select a report, click on the icon and the
report will be displayed in the Report view of the Main screen. The Payroll Interface can be
launched in the same manner. For more information about Reports and the Payroll List, please
refer to: Reporting Functions.

The following illustrates how the Reports and Payroll Icon List appears:
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Report and Payroll View

Located to the right of the Report List and below the Icon menus, the Report/Payroll view
displays the currently selected Report or Payroll. If no report or payroll is selected, this section
will be blank. By default, both the Hours and Reports/Payroll windows are displayed. To view
only the Report/Payroll, select Display from the Main menu, and then choose the submenu
Report or Payroll to remove the Hours Grid Display from the view. Use the Report Sizing and
Scrollbar icons to move throughout the selected report. For more information about Reports,
please refer to section on Reporting Functions. The following are examples of the Report and
Payroll views located on the Main screen:

Report View

Payroll View
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Employee List

The Employee List is Located below the Report/Payroll View and to the left of the Hours Grid
View. The Employee List displays all of the employees currently in the system or employees
that were selected using the Select Employee sort function. As seen in the example, the icon
for the selected employee changes from multiple heads to a single head, indicating that this is
the active employee. The name and badge number will also be displayed on the Status Bar at
the bottom of the screen.

To move from one employee to another, left mouse click on the desired employee. To open an
employee’s record, double click on that employee’s name.

Right mouse clicking inside the Employee List will display a dropdown menu (see above
example) that will allow you to select one of the following operations:

e Add Employee: Allows you to add a new employee.
e Delete Employee: Allows you to delete the selected employee.

72L& Rather than deleting an employee, it is recommended that you make them inactive so that
data can be referred to for historical purposes.

e Employee: Opens the Employee Maintenance screen.
e Department: Allows you to add, edit, and delete departments.
e Schedule: Allows you to add, edit, and delete schedules.

e Sort By: This option allows you to select the sorting method of the Employee List. The
following options are available: Employee Number, Badge Number, Last Name, First Name,
or Department.
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Hours Grid View

The Hours Grid displays all of the information pertaining to the currently selected employee as
shown in the following example. The scroll bars will allow you to scroll through data that does
not fit on the screen. A consistent reference point is the date column, which is fixed as the first
column starting from left to right. All other data may vary depending on where you are in the
Hours Grid. The information displayed in the grid can also be varied based on the selections
made during the setup Wizard.

Date IM OUT | Tetal | Exceptions Schedule REG aT 072 | SCk | HOL | “AC | PER | BER |OT Eefare| OT After
Sun 3/24/2002 75 | LULD | 2200 - 1500 75 Yes | Yes
Mon 3/25/2002 75 u 2200 - 1500| 75 Yes | Yes
Tue 3/26/2002 [ | MP | 2200 - 1500 Yes | Yes
Wed 3/27/2002 MP | 2200 - 1500 Yes | Yes
Thu 3/28/2002 ABS | 2200 - 1500 Yes | Yes
Fri 3/29/2002 ABS | 2200 - 1500 Yes | Yes
Sat 3/30/2002 ABS | 2200 - 1500 Yes | Yes

‘ s

The following is a detailed description of the Hours Grid columns:

Date: A fixed heading displaying the dates of the active pay period.

Blank: A blank column will appear before each IN and OUT punch. These fields will indicate
the date that the punch was recorded on.

IN: By default, Time Guardian displays two IN columns. However, if more than four punches
are entered on a day, an additional row will be automatically added to accommodate the
punches.

OUT: By default, Time Guardian displays two OUT columns. However, if more than four
punches are entered on a day, an additional row will be automatically added to
accommodate the punches.

2& The time displayed in the IN and OUT columns can vary based on selections made during

the setup Wizard. The Grid View option of the Main menu will allow you to modify how the
time is displayed. The default display is Rounded Time.

Total: This column will display the total number of hours worked in a day.
Exceptions: If you select Exception Tracking in your setup, this field will display the flags.

Schedule: This column will display the scheduled IN and OUT time assigned to an
employee. If no schedule is found for the employee, “No Schedule” will be entered as a
default.

Pay Code Breakout: Time Guardian has nine Pay Codes to choose from and selections
made during setup will determine what Codes are displayed. Employee hours will be
displayed accordingly.

Tip/Bonuses Pay Codes: Time Guardian allows you to track Tips and/or Bonuses based
on selections made during setup. For more information on these Pay Codes, please refer to
section on Editing Employees.

OT Before: As determined by your initial setup, overtime hours must either be authorized or
are automatically calculated. This field displays the default selection for your system. For
information on editing this column, please refer to section on Employee Tab (Employee
Administration.

OT After: As determined by your initial setup, overtime hours must either be authorized or
are automatically calculated. This field displays the default selection for your system. For
information on editing this column, please refer to the section on Employee Tab (Employee
Administration.
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Right mouse clicking anywhere in the Hours Grid will display the following dropdown list:

Edit Hours

Delete Haurs

Add Punch

Edit Punch

Delete Punch
Exception Reasan

Edit Dollars

Edit Authorization

Cut kvl
Copy Chrl+iC
Faste Chrl+y

The location of the cursor when you right mouse click will determine the highlighted options
available to you.

2% Edit menus can also be entered by double clicking in the field (the fields must contain data
to be edited) you wish to edit.

The following options for the Edit menus are listed below:

e Edit Hours: This option is active when the cursor is in any of the “Hour Pay Codes” areas.
This selection allows you to add employee hours. All edits are displayed in red.

o Delete Hours: This option is active when the cursor is in any of the “Hour Pay Codes”
areas. This selection allows you to delete employee hours.

e Add Punch: This option is active when the cursor is in any of the “IN” or “OUT” columns.
This selection will allow you to add a punched time in an area where a punch is missing. All
added punches are displayed in red.

e Edit Punch: This option is active when the cursor is in any of the “IN” or “OUT” columns.
This selection will allow you to edit an existing punch. All edited punches are displayed in
red.

o Delete Punch: This option is active when the cursor is in any of the “IN” or “OUT” columns.
This selection will allow you to delete an existing punch.

o Exception Reason: This option is active when the cursor is in the “Exception” column. This
selection will allow you to add reasons to explain existing exception flags.

o Edit Dollars: This option is active when the cursor is in any of the “Dollar Pay Codes”
areas. This selection allows you to add or maodify the dollar amount assigned to any
employee for that day.

e Edit Authorization: This option is active when the cursor is in either the “OT Before” or “OT
After” columns. This selection allows you approve Overtime on a daily or weekly basis.

e Cut: This feature allows you to remove data from a field. CTL+X is the shortcut for this
feature.

e Copy: This feature allows you to copy data from one field to another. CTL+C is the shortcut
for this feature.

e Paste: Once data has been Cut or Copied, this function allows that data to be placed in
different fields by using the Paste function. CTL+V is the shortcut.
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Adding, Editing and Deleting Employee Punches

The following is an example of the Add, Edit, and Delete Punch screens in a side-by-side view.
This is done to demonstrate the similarities in these functions. Each screen displays the
Employee Name, Punch Date, Punch Day and Punch Time.

Employee Punch Date Employes Punch Date Employee Punch D ate
Jolia Felipe |3/25/2002 IX_DﬁD,FeIipe |3725/2002 IX_DﬁD,FeIipe |3/25/2002
Punch Diay Funch Time Punch Day Funch Time Funch Day FPunch Time
IMon 'l I- IMon 'I IMon 'l
@ Save I fL Lloze | y Save I fL Lloze | y Delete I fL LCloze |
Add Punch

The Add Punch module is accessed by double clicking on the desired IN or OUT punch field or
right mouse clicking in the field to reveal the dropdown menu and selecting Add Punch. Enter
the time in the Punch Time field and select Save to close the module.

2% Added or Edited punches or hours will be displayed in red.

Edit Punch

The Edit Punch module is accessed by double clicking on the desired IN or OUT punch field or
right mouse clicking in the field to reveal the dropdown menu and selecting Edit Punch. The
current time will be highlighted in the Punch Time field. Edit the punch and select Save to close
the module.

2% Added or Edited punches or hours will be displayed in red.

Delete Punch

The Delete Punch module can only be accessed from the “Delete Punch” option of the
dropdown menu. Right mouse click on the punch to be removed to display the dropdown
menu, and select Delete Punch. The current time will be highlighted in the Punch Time field.
Select the Delete button to remove the punch and automatically close the module.

2% Once deleted, the only record of the original punch will be in the Audit Trail Report.

Assigning Reasons to Exception Flags

Exceptions are displayed in the Exceptions column of the Hours Grid. Exceptions flags will vary
depending on the selections made during the setup Wizard. When an Exception appears for an
employee, Time Guardian allows you to associate a reason for that flag which will be displayed
as part of the Exception Report. Double clicking on the desired field accesses this module (see
the following figure for an example). You can also right mouse-click in the field and select the
Exception Reason option from the dropdown menu. The Employee Name, Exception Date and
a list of the exceptions for the day will be displayed. The cursor will appear in the Reasons field
where you can enter the desired comments for the reason. Select Save to exit.
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Editing Punches During Daylight Saving Time

During Daylight Saving periods, edited punches are displayed in red. Edited Daylight Saving
Time punches will be displayed in green, and punches adjusted by Time Guardian for Daylight
Saving Time are displayed in blue.

Editing Employee Total Hours, Tips and Bonuses, and Rates (Wages)

The following figure is an example of an Edit Dollars Pay Code box for Tips/Bonuses. Each
view box displays the Employee Name, Punch Date and Punch Day.

Edit Dollars Pay Code x|

Fay Code ITIF'S
Current Valug |$U

Mew Balance % ||

Conment

IL Close

_fices |

The Edit Pay Codes Balance module is accessed by double clicking on the desired field or right
mouse clicking in the field to reveal the dropdown menu. Edit Pay Code is used in two ways: to
edit a pay code balance for adjustment purposes or to add hours for an employee who may be

on vacation or absent.

Each pay code being used by your system has a separate pay code column. Once open, enter
the desired amount in the New Balance field, along with comments associated with the
changes in the Comment field. Select Save to close the module.

When entering a Tip or Bonus code for the first time, the Current Value field will be blank. When
editing an existing code, this field will contain the current value. In both cases, enter the desired
amount in the New Balance $ field along with the comments associated with this action and
select Save to update and close the module. Even though this field contains a dollar value, the
only time a decimal is needed is when entering a number like 5.25.

2% Added or Edited punches or hours will be displayed in red.
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The following figure is an example of a Wages box for Employee Wages. Each Employee
Wages box displays the Employee Name, Date (effective date), and Rate.

You can Add, Edit, or Increase (by percentage) Wages from the following Rates screens:

Editing Overtime Authorization

The following is an example of the Overtime Authorization module for a scheduled employee.
Double clicking on the desired field or right mouse clicking in the field accesses the Edit
Authorization module. A dropdown menu will be displayed, allowing you to select Edit
Authorization.

Time Guardian allows you to select “Yes” or “No” for authorization for a given day. To apply
authorization for the entire week, select “Applies for all days in Pay Period” box. Once your
selection has been made, select OK button to close the module.
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Authorizing Non-Scheduled Hours

To authorize hours for an employee who has worked on a Non-Schedule day, double click in
either of the OT fields. The following Overtime Authorization screen will appear with the “All
Day” check box. Select the OK button to have Time Guardian calculate hours for that day.

Note: If you answered yes to the question “Do hours worked on an unassigned schedule
require authorization?” in the setup wizard, this option will make it easier to authorize
hours for the employee. Until the hours are authorized, no hours will be calculated for the
employee.

Pay Period Hours, Wages and Dollar Totals

The Main view displays the Hour, Wage, and Dollar totals for the selected Pay Period of the
currently selected employee. The totals are sorted by pay code. As seen in the following
example illustration, the number of Pay Codes displayed will vary based on your configuration.

Module Toolbar

Once a module has been opened, a toolbar will be displayed at the top of the screen. The icons
will become active as needed depending upon the screen selected. The following figures
display all of the currently available icons.

B8] 6] X| o =

For the above toolbar example, the icons are, from left to right:

o New icon: Allows you to create a new record in the module.

e Global Assign icon : This feature allows you to assign the same profile to selected
employees (Only available from the Employee information module).

e Editicon . After selecting a record from the list, click on this icon to make edits.
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e Saveicon : Allows you to save changes made to new or edited records.

o Delete icon : Allows you to delete the currently selected record.
e Undo icon : Allows you to undo the last command.
e Closeicon : Allows you to close and exit the module.
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Chapter 4: Using the Wizard

The Wizard (Basic and Advanced) is used to set up Time Guardian. It is also the only place to

change the following items:

e Hours Display

e Minutes Display

o Payroll Setup

e Pay Policy including Rounding, Meals and Overtime settings
e Exceptions

e Pay Codes

e Auto Polling

e Door Access and Bell Schedules
e Backup Schedule

e Department List

e Employee List

e Schedules

e Wages

As shown in the following Figures, the Basic Setup Wizard screen contains three tabs:
General, Pay Policy, and Login. While the Advanced Setup Wizard contains nine tabs:

General, Department, Pay Policy, Pay Code, Exce?tions, Schedule, Em?lo yee, Clock, and

Login. For both Wizards, use the <<Previous or Next>>
between the tabs or click on the desired tab. Once modifications have been made, be sure to
save your changes, select “Finish” button and Close button to exit Wizard. Please refer to th
section and subsequent sections in this User’'s Guide for references to these tabs. It is also
recommended that any changes be recorded in the appropriate Time Guardian Wizard
Worksheet for historical purposes and easy reference.

buttons to navigate

is

Note: If “Disable Wizard Help” is checked, click on the Help
to popup Help screen.

| button while in any tab
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Basic Setup Wizard

Select the Basic Setup Wizard to provide an easy-to-use quick configuration of Time Guardian
for a standard non-complex Time and Attendance system. This wizard does not provide
employee wages/salary pay and/or complex rounding/overtime rules. However, after
completion, you can switch to the Advanced Set Wizard at any time by pressing the

| button.

General Tab

This option allows you to define basic company information for Time Guardian such as:

2.

Company name

Payroll software (select payroll system to interface directly with employee hour hours)
Type of time display (12 or 24 hour clock)

Hour display format

Employee report format

To access this module, select Setup menu from the main menu and Wizard submenu, or
B

click the Wizard icon on the Custom Toolbar. From the Setup Wizard screen, select
the General tab, and the following General screen will appear:

Enter and/or modify company Name.

3. Select Yes or No to the question: Do you want to send employee hours to your payroll

software? If yes, select the icon and the Payroll Software window will open allowing
you to select one of the following payroll software systems: ADP for DOS, ADP for
Windows, CBS PAYROLL, EXCEL, GevityHR, PAYCHEX PAYLINK, PAYCHEX PREVIEW,
PAYDAY of AMERICA, PEACHTREE, POWER PAY, and QUICKBOOKS.

Select 12 Hours (AM/PM) or 24 Hours (Military) to the question, What time display do
you want to use?
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5. Select Minutes or Hundreds of hours to the question, What hour display do you want to
use?

6. Check “Page break for each employee on reports”, if you want page breaks before each
employee.

7. Check “Disable Wizard
disabled, click the Help

if you want popup Wizard Help Screen to be disabled. If

| button to popup help.

Pay Policy Tab

This option allows you to define pay policy. To access this module, select Setup menu from the
main menu and Wizard submenu, or click the Wizard icon on the Custom Toolbar. From the
Setup Wizard screen, select the Pay Policy tab, and the following Pay Policy screen will
appeatr:

The following options are available from the interval field dropdown menu:
o Weekly: Employees are paid every week.

o Bi-Weekly: Employees are paid every two weeks.

e Semi-Monthly: Employees are paid twice a month.

e Monthly: Employees are paid once a month.

A Start Date for the Pay Period is also required. Click the down arrow to display the calendar,
and double click on the desired date to populate the field.

Overtime

Time Guardian Basic Setup Wizard was designed to accommodate a set variety of overtime
rules. Depending on your setup, the following settings may need to be configured:

e Type of overtime:

a. Daily overtime will award overtime after the assigned number of hours has been worked
in a day [enter number for hours/min].

b. Weekly overtime will award overtime after the assigned number of hours has been
worked in a week [enter hours and min].
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Note: Placing a checkmark in front of both of these options will have Time Guardian calculate
Overtime based on the hours entered in Daily Overtime, and then the hours entered in
Weekly Overtime.

o Overtime is reset on a specific day of the week

2 & This is especially useful if an employee is assigned to a Bi-Weekly, Semi-Monthly or
Monthly Pay Period and the Overtime rules are based on a seven-day cycle starting on
a specific day.

Punch Rounding

The Rounding Rules utilized in the Basic Setup Wizard were designed to simply accommodate
a set variety of overtime rules. Depending on your setup, the following choices are available for
punch rounding:

¢ No Rounding — default setting
o Nearest quarter (15/7)
e Nearest tenths (6/3)

e Split rounding —where IN punch will round to next 15 min, interval at 5 min. OUT
punch will round to next 15 min, interval at 10 min.

The Rounding for the Basic Setup Wizard can be seen in the following table:

Split Rounding
Unit 15/Point 7 Rounded Unit 6/Point 3 Rounded Unit 15/Point 5 Unit 15/Point 10
Punch Time Time Punch Time Time split Rounding IN RO#PndeEd Split Rounding OUT Roﬁrf]lqi*?d
Punch Time Punch Time
8:15 8:15 8:15 8:18 8:15 8:15 8:15 8:15
8:16 8:15 8:16 8:18 8:16 8:15 8:16 8:15
8:17 8:15 8:17 8:18 8:17 8:15 8:17 8:15
8:18 8:15 8:18 8:18 8:18 8:15 8:18 8:15
8:19 8:15 8:19 8:18 8:19 8:15 8:19 8:15
8:20 8:15 8:20 8:18 8:20 8:30 8:20 8:15
8:21 8:15 8:21 8:24 8:21 8:30 8:21 8:15
8:22 8:30 8:22 8:24 8:22 8:30 8:22 8:15
8:23 8:30 8:23 8:24 8:23 8:30 8:23 8:15
8:24 8:30 8:24 8:24 8:24 8:30 8:24 8:15
8:25 8:30 8:25 8:24 8:25 8:30 8:25 8:30
8:26 8:30 8:26 8:24 8:26 8:30 8:26 8:30
8:27 8:30 8:27 8:30 8:27 8:30 8:27 8:30
8:28 8:30 8:28 8:30 8:28 8:30 8:28 8:30
8:29 8:30 8:29 8:30 8:29 8:30 8:29 8:30
8:30 8:30 8:30 8:30 8:30 8:30 8:30 8:30

Login Tab (Profile Definition)

There are three possible levels of Access Rights, controlled by the two check boxes marked
Administrator and Read-Only. The following describes the access rights given to users based
upon checkbox selection:

o Administrator Checkbox selected: Grants the full ability to add, modify and edit any data
contained in the system, including all employee and Time Guardian user login data.

Note: Only administrator's can view employee wages.
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¢ No Checkboxes Selected: The user has the same access as an Administrator with regard
to employee data (except wages), but cannot access or modify the Time Guardian user
login data.

o Read-Only: Can view all data (except wages) in the system but cannot modify any data or
add any new data.

Note: During Basic Wizard setup at least one Administrator profile will be created.

Additional Profiles can be added, and/or existing Profiles can be modified using the following
three different methods:

1. Open the Login Profile module. This can be done by using either of the three following
methods:

a. 1% method: Selecting Setup from the Main Menu, and clicking the Login Profiles
submenu.

b. 2" method: Selecting Setup from the Main Menu, and clicking the Wizard submenu.
From the Setup Wizard screen click the Login tab and the Login Profile screen will
appear.

c. 3" method: Clicking on the Wizard L=1 icon in the Custom Toolbar to display the Setup
Wizard screen, selecting the Login tab, and the following Login Information screen will

appear:

2. Select Login Profiles from the Setup Menu and the Login Profile screen (see the following
figure) will appear:
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3. click on the £ button. From the Login Profile screen, you must select “Add”

before a new Profile can be created, and the “Add New Profile” window will appear:

Enter the Name of the user in the Add New Profile window (see the above figure).
Enter and confirm the password.

Select Language from drop down menu.

N o g &

Select if the profile will have Administrator or Read Only access. Press the “Save” button. At
this point if neither box is checked a plain User is created (see "No checkboxes" above).

8. Select the “Advanced Password” tab to configure password expiration options and the
following screen will appear:

9. When finished, the new profile will be created and added to the Authorized Users list.
Highlighting a name on the list and selecting the “Default User” box will make that user the
default name and it will appear each time the software is opened.

2% All Profiles are case and space sensitive. If you have a problem accessing the software,
confirm the login information and try again.

Advanced Setup Wizard

Select the Advanced Setup Wizard to provide a more detailed configuration of Time Guardian
for a complex Time and Attendance system. This wizard provides employee wages/salary pay
and/or complex rounding/overtime rules. However, after selection, you cannot revert back to the
Basic Setup Wizard.
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General Tab

This option allows you to define general company information for Time Guardian such as:

Company profile

Payroll software (select payroll system to interface directly with employee hour hours)
Type of time display (12 or 24 hour clock)

Hour display format

Employee report format

To access this module, select Setup menu from the main menu and the Wizard submenu,
or click the Wizard B icon on the Custom Toolbar. From the Setup Wizard screen, select
the General tab, and the following General screen will appear:

Click the icon to display the Company Profile screen to enter and/or modify company
information such as: Name, Address, City, State, Zip, Country, Phone, and Comments.

Select Yes or No to the question, Do you want to send employee hours to your payroll

software? If yes, select the icon and the Payroll Software window will open allowing
you to select one of the following payroll software systems: ADP for DOS, ADP for
Windows, CBS PAYROLL, EXCEL, GevityHR, PAYCHEX PAYLINK, PAYCHEX PREVIEW,
PAYDAY of AMERICA, PEACHTREE, POWER PAY, and QUICKBOOKS.

Select 12 Hours (AM/PM) or 24 Hours (Military) to the question, What time display do
you want to use?

Select Minutes or Hundreds of hours to the question, What hour display do you want to
use?

Check “Page break for each employee on reports”, if you want page breaks before each
employee.

Check “Disable Wizard Help”, if you want popup Help Screen to be disabled. If disabled,

click the Help
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Department Tab

This option allows you to add or edit Departments. To access this module, select Setup menu
from the main menu and Wizard submenu, or click the Wizard icon on the Custom Toolbar.

From the Setup Wizard screen, select the Department tab, select Yes or click icon, and
the following Department screen will appear:

x|

General Departmert ]F'ay Paolicy | Pay Ende] Exceptions Schedule] Empln_uea] Clock ] Lngin]

‘would you like ta zet up departments 7

i Mo

* Yes E

Department : Manufacturing g]

blE[X|o] =
Mumber: "muui

Mame: ||Manufacturing

Department List:

Commernts:
Technical Suppart

<<E|evious| Heat »> | & Finish | ﬁguse | ?ﬂelp |

Once a department has been added or edited, click the save icon to save changes before
closing the module.

The Department module consists of four areas. The following describes each of these areas:
¢ Number: A mandatory field that can only contain numeric values.

e Name: A mandatory field that will be displayed throughout the software to describe the
Department.

¢ Comments: An optional field used to enter specific comments about the Department.

o Department List: This list box will display all the Departments created for your system.

Pay Policy Tab

This option allows you to define pay policy. To access this module, select Setup menu from the
main menu and Wizard submenu, or click the Wizard icon on the Custom Toolbar. From the
Setup Wizard screen, select the Pay Policy tab, and the following Pay Policy screen will
appear:
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From the Pay Policy screen, click on the
screen will appear:

icon, and the following Pay Policy Settings

& Pay Policy Settings

D) 5| x| i
Name Son-2off-Bam-5pm Pay Policy List

Son:

Pay Pnlic_v] Rounding Rules ] Meal Rules ] Advanced Dvertime ]
General Settings

Thiz pay policy will be paid on a Bitw'eekly | interval
‘Wihat iz the start date for this pay period ? 43172006 -

Overtime Setup

Does overtime apply for this pay policy? W
Do emplovess receive overtime when they work on Holidays 7 v
Type of avertime
[v Daily avertime after 05:30

v “weekly overtime after 40+ ke [0 = min

Overtime is reset on

e Pay period start date

" Specific day of the week

v Advanced Settings

Define your company's day change time 02:00 &M
Day change occurs
™ Before midnight & After midnight

M awirum hift length 12 2{he |59 5| min

The following options are available from the interval field dropdown menu:
e Weekly: Employees are paid every week.

o Bi-Weekly: Employees are paid every two weeks.

¢ Semi-Monthly: Employees are paid twice a month.

e Monthly: Employees are paid once a month.

A Start Date for the Pay Period is also required. Click the down arrow to display the calendar,
and double click on the desired date to populate the field.
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Time Guardian was designed to accommodate a wide variety of overtime rules. You can cancel
all authorized overtime by clicking No to the question; Do you want to authorize your
employee's hours? Depending on your setup, the following settings may need to be
configured:

o Does overtime apply for this pay policy?
a. Overtime may be awarded daily after an employee works the defined number of hours.

b. Overtime may also be awarded weekly after an employee works the defined number of
hours.

o Do employees receive overtime when they work on holidays?
o Type of overtime:

b. Daily overtime after [enter number for hours/min]

c. Weekly overtime after [enter hours and min]
e Overtime is reset on:

a. At the start of a pay period

b. On a specific day of the week

20X This is especially useful if an employee is assigned to a Bi-Weekly, Semi-Monthly or
Monthly Pay Period and the Overtime rules are based on a seven-day cycle starting on
a specific day.

20X This setting is most common when an employee is assigned to a Weekly Pay Policy.

Also on the Pay Policy Settings screen is the “Advanced Settings” check box. Selecting this will
display the following screen:

Define your company's day change time |1 .00

[iay change occurs
= Before midnight * After midnight

b aximum shift length |1-'-1 3, hrs |59 5, i

Advanced Settings should only be changed if employees are scheduled to start work after
02:00 AM and you want those hours applied to the current day.

Midnight (00:00) marks the start of a new day. However, there are times when an employee is
scheduled to start on one day and end on another (i.e. start work at 10:00 PM Sunday and
leave work at 6:00 AM Monday).

Advanced Settings allow Time Guardian to account for a midnight day-change time and
calculate the number of hours correctly, placing the punches on the current day.

Using the example above, there are two scenarios where the hours can either be applied to
Sunday or Monday.

Scenario #1

If you want the hours applied to Sunday, then Sunday becomes the Current day and the hours
from Monday are shifted backwards to Sunday.

Scenario #2

If you want the hours applied to Monday, then Sunday becomes the Previous day and the
hours from Sunday are shifted forwards to Monday.
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In either scenario, the Day Change Time must be configured. The exception to this rule is when
a punch occurs after the day change time, but falls within the Maximum shift length. The
Maximum shift length (window) is the period of time that punches will be calculated for a
schedule that crosses day change time: 12 —13 hours is a recommended number for this field.
This allows all lunch or break punches to be applied to the correct schedule.

In the examples below, 2:00 AM will be used for the Day Change Time. Once defined, you must
determine if this time is to start Before or After midnight. When Before midnight is selected, all
hours from 00:00 — 2:00 AM will be recognized by Time Guardian as part of the Previous day.
Anything after 2:00 AM will be applied to the Current or New Day.

When After midnight is selected, all hours from 00:00 — 2:00 AM will be seen by Time Guardian
as part of the Current day and anything beyond 2:00 AM will be applied to the Next day.

Examples of “Before” and “After” midnight settings:

2:00 AM Before Midnight means that all punches up to 2:00 AM will be applied to the
Previous day and any punch after 2:00 AM will be applied to the Current day.
2:00 AM After Midnight means that all punches up to 2:00 AM will be applied to the

Current day and any punch after 2:00 AM will be applied to the Next day.

10:00 PM Before Midnight means that all punches up to 10:00 PM will be applied to the
Previous day and any punch after 10:00 PM will be applied to the Current day.

10:00 PM After Midnight means that all punches up to 10:00 PM will be applied to the
Current day and any punch after 10:00 PM will be applied to the Next day.

e The following timeline illustrates an employee punching in at 8:00 PM and punching out at
4:00 AM.

e The day change time is set to 2:00 AM.

e The Day Change is configured to Before Midnight, with a maximum shift length of 12 hours
and 59 minutes.

Even though two of the punches (2:30 AM and 4:00 AM) occur after day change time, they are
within the maximum shift length and are calculated on the same day (the day the IN punch
occurs).

Maximum Shift Length 12:59

< s:00PM 1:00 AM }‘2:30AM 400 AM "> 8:59 AM
§ T T—-—| 1
Day Change Time Same Day Calculation
2:00 AM

Key

l =In Punch T = Out Punch
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Rounding Rules Tab — Pay Policy

Rounding was created so that employers could define rules that would allow employees’
punched time to be rounded to a defined unit. The time that the employees’ punches move
forward or backward is based on a defined point. This allows all of the hours to be better
managed for payroll purposes. Time Guardian allows you to apply the defined Unit and Point to
individual punches (Punch Rounding) or the daily total of hours worked by an employee (Daily
Rounding). For Punch Rounding, you must specify the Unit and Point individually for both the
IN and OUT punches. A Time Simulation tool has been included in Time Guardian to test your
settings. See Troubleshooting Calculations for more detailed information.

The example table below is provided to give you a visual example of where a defined Unit
starts and ends. Time Guardian only allows the Unit to be one of the following numbers: 1, 3, 6,
15 or 30. Selecting 1 would be minute to minute, thus no example is shown.

3 Unit 6 Unit 15 Unit 30 Unit
00:00 (First Unit Start) 00:00 (First Unit Start) | 00:00 (First Unit Start) | 00:00 (First Unit Start)
00:01 00:01 00:01 00:01
00:02 00:02 00:02 00:02
00:03 (Next Unit Start) | 00:03 00:03 00:03
00:04 00:04 00:04 00:04
00:05 00:05 00:05 00:05
00:06 (Next Unit Start) | 00:06 (Next Unit Start) | 00:06 00:06
00:07 00:07 00:07 00:07
00:08 00:08 00:08 00:08
00:09 (Next Unit Start) | 00:09 00:09 00:09
00:10 00:10 00:10 00:10
00:11 00:11 00:11 00:11
00:12 (Next Unit Start) | 00:12 (Next Unit Start | 00:12 00:12
00:13 00:13 00:13 00:13
00:14 00:14 00:14 00:14
00:15 (Next Unit Start) | 00:15 00:15 (Next Unit Start) | 00:15
3 Unit 6 Unit 15 Unit 30 Unit
00:16 00:16 00:16 00:16
00:17 00:17 00:17 00:17
00:18 (Next Unit Start) | 00:18 (Next Unit Start) | 00:18 00:18
00:19 00:19 00:19 00:19
00:20 00:20 00:20 00:20
00:21 (Next Unit Start) | 00:21 00:21 00:21
00:22 00:22 00:22 00:22
00:23 00:23 00:23 00:23
00:24 (Next Unit Start) | 00:24 (Next Unit Start) | 00:24 00:24
00:25 00:25 00:25 00:25
00:26 00:26 00:26 00:26
00:27 (Next Unit Start) | 00:27 00:27 00:27
00:28 00:28 00:28 00:28
00:29 00:29 00:29 00:29
00:30 (Next Unit Start) 00:30 (Next Unit Start) | 00:30 (Next Unit Start) | 00:30 (Next Unit Start)
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This pattern will repeat itself throughout the entire day.

The following is an example of the Rounding Rules tab in the Pay Policy Settings module. This
menu will allow you to customize your rounding rules.

':gu Pay Policy Settings El .
0/ | ] =
Neme |[Son-Zofi-BamSpm Piay Policy List

5on-Zoff-Bam-Gpm

Pay Policy  Rounding Hulﬂ] Meal Rules } Advanced Overtime ]
Does this policy have rounding miles?

" Nao

« e
Rounding Rule

" Doaily rounding [Rounds by total time]

@ Punch rounding [Rounds each punch)

Founding Rule
In Out

Define your unit 15 - 15 -
Drefine your point R

Sirnulation

Meal Rules Tab — Pay Policy

The following is an example the Meal Rules tab located in the Pay Policy Settings module. This
tab will allow you to define the Meal rules for a group of employees. Start by selecting Yes to
the question "Do you want time deducted for a meal?" Next enter the Minimum hours that an
employee must work before the Meal rule will be applied, followed by the length of the Meal
deduction.

|
olEx

Pay Policy | Rounding Rules  Meal Rules | Adwvanced Overtime test

Do you want time deducted for & meal?
" No
& ied

Iinimurm hours to work before deduction
el deduction

[v Do employees punch at meal time?

" Meal Hours rounding [Rounds by meal kotal time]

* Meal Punches rounding (Rounds each meal punches)

Meal rounding

Drefirie: your unit 'l Simulat
imulation

Define your paint 7 &

Hours towark before start of meal window :

Length of meal window :
Meal grace :

Once a meal deduction is defined, you have the option of whether the employee will punch out
during the meal period. If so, you must define whether rounding will apply to these meal period
punches. When an employee punches IN and OUT for their meal, the window that these
punches occur in must be defined so that the meal will not be deducted twice. To prevent meal
punches from being deducted twice, check the box next to the question “Do employees punch
at meal time?”
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The concepts for meal rounding are the same as those used in the Rounding Rules tab. If
rounding is to be used for meal punches, enter the desired Unit and Point. You must also enter
the number of hours an employee must work before the meal period in the “Hours to work
before start of meal window” field.

For example, if the scheduled start time is 9:00 AM, and the Hours to work is set to 3:00, then
the meal window for this employee would start at 12:00 PM. If the scheduled start time is 7:00
AM, and the hours to work is set to 3:00, then the meal window for this employee would start at
10:00 AM.

Enter the Length of Meal window. This is the length of time between an employee's meal
punches that will be applied toward the meal rule.

Enter in the Meal Grace. This is the number of minutes that an employee can return late from a
meal before additional time is deducted.

Advanced Overtime Tab — Pay Policy

This tab is used to set the overtime rules for Pay Policies that have multiple settings for Dalily,
Weekly, Consecutive Day, and Weekend overtime. The options displayed for Daily and Weekly
Overtime 1 or 2 are displayed only if they are enabled and the initial number of hours that must
be worked for each are defined in the Pay Policy tab. The following is an example of the
Advanced Overtime tab:

o/ &l x| &l
Mame ’m
Pay Palicy } Rounding Rules ] Medl Rules  Advanced Overtime
Daily wieekly avertime
[ Daily Overtime v ‘weekly Overtime
WesklyOT |

assigh to

‘weekly Overtime 1 40 1] aT -

azsigh to

wheekly Dvertime 2 50 % hrs |0 | min arz -

Saturday/Sunday overtime

[ A [ Congecutive Day Overtime
We |

Saturday
Overtime 1 08:00  assign to ar A
Overtime 2 10:00  assign to aTz -

Sunday
Overtime 1 08:00  ssign to o7 i
Overtime 2 10:00  agsign to otz -

Daily Overtime Tab — Advanced Overtime

I ‘weekly Dvertime

Dzily Owertime 1 IDB: on assign to aT A
Doaily Owvertime 2 |1D: i} azzigh to aT2 =
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To configure the Daily Overtime options, click on the Daily Overtime checkbox. The Daily
Overtime 1 setting is displayed here as read-only, since it was configured in the Pay Policy tab,
and must be assigned to a pay code to be awarded. The Daily Overtime 2 setting is added by
entering the number of hours that must be worked and assigning the pay code to be awarded.
Please note that Daily overtime levels are not used in the Weekly overtime calculation.

Weekly Overtime Tab — Advanced Overtime

—Dallpfwieekly overtime
W Daily Overtime

Daily 0T ‘weekly OT |

agzigh to
Wieskly Overtime 1[40 ks 0 min |07 =]

azzign to
‘wieekly Overtime 2 |5U 2 s IU 2| min IDT2 |

To configure the Weekly Overtime options, click on the Weekly Overtime checkbox. The
Weekly Overtime 1 setting is displayed here as read-only, since it was configured in the Pay
Policy tab, and must be assigned to a pay code to be awarded. The Weekly Overtime 2 setting
is added by entering the number of hours that must be worked and assigning the pay code to
be awarded.

Weekend Overtime Tab — Advanced Overtime

[~ Consecutive Day Overtime

zecutive Day 0T |

Saturday
Overtime 1 IUSZUU agsign to o7

Dwvertime 2 |1U:UU assign to arz hd

J

—Sunday

Overtime 1 IDE'DD agsigh to o7

Overtime 2 |1D:UU assign ta aTz2 %

J

To configure the Weekend Overtime options, click on the Weekend Overtime checkbox. Up to
two levels of overtime can be assigned for Saturday and Sunday. For each day, enter in the
number of hours that must be worked and assign the pay code to be awarded for each level
(Overtime 1 and Overtime 2). If Overtime 1 is to be used for all hours worked on either
Saturday or Sunday, 00:00 must be entered in the hours field for the corresponding day, and
the overtime hours awarded must be assigned to the OT or OT2 pay code.

Consecutive Day Overtime Tab — Advanced Overtime

S aturday/Sunday overtime
I~ weekend Overtime

‘weekend 0T Conzecutive Day OT I

Consecutive Day Dvertime Level 1:

Number of Consecutive Days |1 >

Consecutive Day Overtime 1 [02:00 assign ta aT =
Consecutive Day Overtime 2 |1 0:00  assign to arz =

Consecutive Dap Dvertime Level 2

Mumber of Consecutive Days ID >
Consecutive Day Overtime 1 I : azgigh ko I 'I
Corzecutive Day Overtime 2 I : azsidh o I 'I
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Consecutive Day Overtime awards overtime based on the qualifying number of consecutive
days worked. If an employee fails to work the number of consecutive days needed to qualify, no
overtime is awarded.

Up to two levels of overtime can be set for Consecutive Day Overtime calculations. Each level
consists of two settings, Consecutive Day Overtime 1 and 2. To enable this option, click on the
Consecutive Day Overtime checkbox.

For Level 1, select the number of consecutive days (up to 7), then enter the number of hours
that must be worked and assign the pay code to be awarded for each setting (Consecutive Day
Overtime 1 and 2). If Consecutive Day Overtime 1 is to be used for all hours worked, 00:00
must be entered in the hours field for the corresponding day and the overtime hours awarded
must be assigned to the OT or OT2 pay code.

For Level 2, select the number of consecutive days (up to 7), then enter the number of hours
that must be worked and assign the pay code to be awarded for each setting (Consecutive Day
Overtime 1 and 2). If Consecutive Day Overtime 1 is to be used for all hours worked, 00:00
must be entered in the hours field for the corresponding day and the overtime hours awarded
must be assigned to the OT or OT2 pay code.

Pay Code Tab

Pay Codes are initially selected during the Setup Wizard. They determine how an employee’s
hours will be categorized and displayed throughout the system. The Pay Code module is also
where company holidays are entered. Modifications made to this module can only be done
through the Wizard.

The following illustrates an overview of this module, which is divided into four sections:

The first section requires you to select the Pay Codes that will be used to allocate employee
hours. Your options are: Regular, Overtime, Overtime2, Sick, Holiday, Vacation, Personal,
Bereavement, and Miscellaneous. Placing a check mark in front of the code(s) to be used for
your system will allow them to be displayed in the Employee Data and Total Grids located on
the Main view.

Once the Pay Codes have been selected, the decision must be made as to whether or not each
Pay Code will count toward OT (Overtime) and/or Count towards their daily attendance. When
a Pay Code counts toward OT, hours assigned to that Pay Code are counted toward the weekly
overtime requirement as set in the Pay Policy module.
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“Counts towards Daily Attendance” is used when tracking absences for employees who have
an assigned schedule. By awarding an employee hours assigned to a Pay Code that counts
towards their daily attendance, the Absent Exception will be eliminated for the employee.

The second section of the Pay Code module allows you to select whether or not your

i
I

employees will be receiving Tips and/or Bonuses. Click on the
screen will appear:

icon, and the following

x|
TIPS - Dollars tips
BONUS - Dollars borws & 5878 |

Totals for these Pay Codes will appear in the Employee Totals section of the Main View.

To use either of these Pay Codes, place a check mark in front of the box. Tips and Bonuses are
given to an employee by double clicking the desired field in the Hours Grid.

The third section of the Pay Code module allows you to add, edit or delete company holidays

by clicking on the icon and the following Holiday Setup screen will appear. Since the dates
of holidays change from year to year, this section must be updated yearly to ensure accuracy. It
is also suggested that the Holiday Pay Code be selected prior to adding your holidays. If it has
not been selected, you will be unable to assign holiday hours to the Holiday Pay Code.

ol @ x| =l | |l | =]
Holiday Setting I Pay Policy Assign Holiday Setting Pay Palicy Assign
MNarne : T hanksagiving D ay hda L't' " Holiday Pay Palicy
hanksgiving Day Ry Tt
Em _u - Thanksarvina Day..........} B 13 Pay Policy #1
Date: 1172272001 ||| |New tears Day Christmas Day I Thanksg
temarial Day uzm;;‘?g;ay Christmas
e Cag] = Labor Day
e Independence Day Labor Day E New Y?a
prezsidents day Independence Day o - Memorial
o =00 ot presidents day EE -l | abor Da
test Assign ¥ Independ
oI president:
Comments: ;I ] test
=] Holiday Policy
Thankzgi
[0 Chiigtmas
] Mo Yea T
_I 1 | | »
-

As seen in the figure above, the Holiday Setup module consists of two tabs. The one to the left
is the Holiday Setting tab, where information is entered about the specific holiday. To the right
is the Pay Policy Assign tab, where the created holidays are assigned to a specific Pay Policy.

The Holiday Setting tab is comprised of the following areas:

¢ Name: A mandatory field that contains the name of the holiday.
o Date: A mandatory field that allows you to enter the date of the holiday.

e Pay Code: A mandatory field that allows you to select the Pay Code that will be awarded for
that holiday.
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¢ Hours: A mandatory field that allows you to specify the number of hours to be awarded for
the holiday.

o Comments: An optional field used to enter specific comments about the holiday.
o Holiday List: This list box will display all of the holidays created for your system.

2 X If a salaried employee punches in on a holiday, they will only receive holiday hours.
However, if an hourly employee punches in on a holiday, they will receive both the hours
worked and the holiday hours.

The Pay Policy Assign tab is divided into two sections. The Holiday area contains a list of all the
user-created Holidays. The Pay Policy area contains all of the Pay Policies. To add a holiday to
a pay policy, highlight the holiday name and select the Assign button. The holiday will then
appear under the desired Pay Policy. To remove an assigned holiday, highlight the name under
the Pay Policy and hit the delete key on your keyboard.

The fourth section of the Pay Code module allows you to select whether or not your employees

g
"

will be tracking Wages. Click on the icon, and the following Pay code rate multiplier screen

will appear:

Totals for these Pay Codes using these multipliers will appear in the Employee Totals section of
the Main View.

To show wages information (calculation) on Timecard, Hours Worked, and Summary Reports,
place a check mark in front of the box. See the section Reporting Functions for an example of
wages on reports.

Exceptions Tab

Time Guardian has nine (9) Exceptions that can be made active or inactive by adding or
removing check marks (see the following figure).

When selected, Exceptions are displayed in the Exception column of the Employee Grid and
used to flag the selected criteria for attendance purposes. Exceptions and Exception Reasons
are displayed in the Exception Report.

2% If an employee has a MP Exception, no other Exceptions will appear until the missing
punch is added. At that point, all additional Exceptions will be displayed.
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Schedule Tab (Schedule Administration)

This option allows you to add, edit or delete Employee Schedules. To access this module,
select the Setup menu from the main menu, and Wizard submenu, or click the Wizard icon on
the Custom Toolbar and select the Schedule tab (see the following figure). At least one
schedule must be created for employees that have been designated as ‘salaried’. Hourly
Employees do not need schedules. Once the Schedule has been added or edited, click on the
“Close” icon to save the settings and exit the module.

To add a new schedule, follow these steps:
1. From the Schedule tab in the Setup Wizard screen, click Yes to the question, Do you want

B

display the Schedule screen. Next, click on the New icon and enter the name for the
schedule in the Schedule Name field.

to create schedules for your employees?, and click the Schedule Information icon to

Hit enter or tab keys to display the schedule setup fields.

Will the schedule cross midnight? If “No” is selected, then the basic schedule setup is
displayed.

4. Enter the Start and End time for the schedule and select the active days.
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5. Click

the ‘Ok’ button when finished.

The Schedule View section will display the schedule created.

2 X Different start times can be applied to one schedule by selecting a day for the first start time
and selecting OK. Edit the schedule, select additional days and enter another start time.

The following is an example of the schedule setup module:

To ensure that an employee’s hours are awarded on the correct day for a Schedule that
crosses Midnight, you must define the Start and End times. The options for the Start Time are:

Previous

Day, or Current Day. The options for End Time are: Current Day, and Next Day.

Previous: Previous is selected when an employee punches in on the night before the

Current:

Next:

scheduled day and you want the hours applied to the current day. Example: An
employee that starts working on Sunday will have those hours applied to Monday.

When a schedule crosses midnight, this setting is used to indicate the actual day
that you want the punches applied to. At least one punch must be Current.

Next is selected when an employee punches out after midnight and you want those

punches from the next day applied to the current day. Example: An employee starts
work on Monday night and doesn’t punch out until Tuesday morning but those hours
should be applied to Monday.

The following is an example of a schedule that ends on the current day:

=
g st =1 et I =

reeiEEibe e End Does this schedule cross midnight?
Mon mus:uu mzu:uu & e " No
Start
Tue iEI]B:I]I] iﬂzu:uu l—
0g:00
Wed ﬁ]us:uu ﬁlZl]:l]l] o Erias Day
& Curent D
oo [oso0  [Eeo-00 HEE
End
Eri lﬂus:uu IﬁZl]:l]l] 20:00 o A
s [Efoso0  EEeo00 & CureniDey O Cancel
i Mext Day
Sun mus:uu le]:l]l]
(0]4 | Cancel |
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The Start and End times only have to be entered once and will be applied to all days with check
marks. Time can be entered in military or AM/PM format depending on your settings. Below is
an example of the Start and End times that would need to be entered for a schedule from 9 AM
to 5 PM:

Military Time AM/PM
Start 09:00 9:00 AM
End 17:00 5:00 PM

Once created, schedules will appear in a list box. To edit, double click on the desired schedule
and make the necessary changes. Click the Save icon to exit and Save.

Employee Tab (Employee Administration)

The Employee Administration menu can be accessed from the following locations in Time
Guardian:

o From the “Employee” option on the main menu.
o From the Setup Wizard (Advanced) module on the main menu.

¢ By right mouse clicking anywhere in the Employee List section of the Main view, and once
open, the dropdown menu shown below will appear:

Add Emploves
Delete Emploves
Emploves
Department
Scheduls

Sotk By ... b

From this list you can administer employees, add departments or schedules, and select sorting
criteria.

The Employee tab allows you to define employees. To access this module, select the Setup
menu from the main menu and Wizard submenu, or click the Wizard icon on the Custom
Toolbar. From the Setup Wizard screen, select the Employee tab, and the following Employee
screen will appear:

Time Guardian v4.0 User's Guide 4-21



Note: Sync Employee(s) with Payroll provides automatic integration with QuickBooks. This
selection only appears if QuickBooks was selected as your payroll software.
Importing Employees

If you want to import employee(s) information from your payroll data, click Yes to the question,
Do you want to import employee information from your payroll software? and if you have to,

click on the Import Employee icon, and the following Employee Import dialog will appear:

Adding Employees
From the Employee tab screen, click Yes to the ?uestion, Would you like to enter employees at

this time? Click on the Employee Information
Information screen will appeatr:

icon, and the following Employee
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Note: All fields outlined in Red are mandatory.

The Employee Information module consists of five tabs: General, Personal, Salary Pay,
Wages, and Fingerprint. Below is an overview of each of these tabs including field names and
definitions. The fields outlined in red are mandatory and no record can be saved without the
proper information being entered. Time Guardian can easily accommodate employees with the
same first or last name, however the Employee Number must be unique since it is the primary
sorting key. Badge Numbers can be changed or reused should an employee lose the badge or
become inactive. Each tab also has an Employee List and double clicking a selected employee
on this list will cause their information to become active in all fields.

There are two options for “Type of Employee”: Hourly or Salary. By Time Guardian standards,
an Hourly employee is one who punches daily at the clock and may or may not have an
assigned schedule. Salary employees are not required to punch and therefore, they must have
an assigned schedule for each day they are expected to work. When Salary is selected, the
Salary Pay tab will become active. In this tab, you must identify how the salaried employee is to
be paid.

The options for Salary Pay Type are:

e By Hours: A set number of hours are entered, and this amount will be awarded for each
day scheduled.

e By Schedule: This option will calculate the amount of time contained in the assigned
schedule and award that number for each day scheduled. If no schedule is assigned, and
the employee does not punch IN or OUT, they will receive no hours for that day.

Once the employee has been added or edited, click on the “Close” icon to save the settings and
exit. Below is a description of all of these fields:

General Tab Fields - Employee

o Last Name: A mandatory field for each employee containing his or her last name.
o Middle Name: An optional field containing the employee’s middle name.

e First Name: A mandatory field for each employee containing his or her first name.

e Employee Number: A mandatory field for each employee containing his or her unique
employee number.

e Badge Number: A mandatory field for each employee containing his or her unique badge
number or PIN.

e Type of Employee: There are two options to identify your employees: Salary and Hourly
(Default).

o Department: The default field is “No Department,” however, if you have chosen to create
departments for your system, the dropdown list will display additional options.

e Schedule: The default for this field is “No Schedule,” however if you have chosen to create
schedules for your employees, the dropdown list will display additional options.

e Pay Policy: A mandatory field for each employee. The dropdown list will display all options
available for your system.

e Hire Date: This field defaults to the date that the employee was added, and can be modified
by clicking on the down arrow to display a calendar. Double-click on the desired date to
close the box and populate the field.
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Holiday Eligibility Date: This field defaults to the date that the employee was added, and
can be modified by clicking on the down arrow to display a calendar. Double-click on the
desired date to close the box and populate the field.

In addition to the above information, there are two check boxes at the bottom of the “General”

tab:

Inactive: When selected, the employee will be considered inactive and will no longer be
displayed on reports or count towards your employee total.

Not Eligible for Holidays: When selected, the employee will not be awarded holidays as
defined in Pay Code setup.

Personal Tab Fields - Employee

The optional fields in the section are:

Address: The place to enter an employee’s address.

City: The place to enter an employee’s city.

State: The place to enter an employee’s state.

Country: The place to enter an employee’s country.

Zip Code: The place to enter an employee’s zip code.

Phone: The place to enter an employee’s phone number.
DOB: The place to enter an employee’s date of birth.

SS#: The place to enter an employee’s social security number.
Gender: The place to specify the gender of an employee.

Comments: The place to enter specific comments about an employee.

Salary Pay Tab Fields - Employee

This tab is only available when “Salary” has been selected as the Type of Employee.

Salary Pap Type

| By Schedule

e By Hours: Enter the number of hours that the employee will be awarded for each day
scheduled. The default for this setting is 8.

e By Schedule: Time Guardian will calculate the amount of time in an assigned schedule
and subtract mealtime if applicable and award the employee the appropriate amount of
hours for each day scheduled.
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Wages Tab Fields - Employee

This tab is used to add, edit, increase, or delete Employee Wages (see the following figure).

¢ Add: Select the Add button to create a wage rate for an employee for on a specific date

(see the following figure). The created wage will remain in effect from that date until it is
altered.

o Edit: Select the Edit button to modify the wage rate and/or date for the employee (see

the following figure). The edited wage will remain in effect from that date until it is altered
again.

Note: You can only have one rate per employee per day.

e Increase: Select the Increase button to incrementally increase a wage rate by a

percentage for an employee on a specific date (see the following figure). The increased
wage will remain in effect from that date until it is altered.

o Delete: Select the Delete button to remove the wage rate on that date for the employee.
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Fingerprint Tab Fields - Employee

This tab is only available when the employee has been assigned to a location which has a
“Fingerprint” selected as the terminal type (see figure).

This tab is used to edit Employee privileges at the fingerprint terminal (see the following figure).
Also, this screen will display the amount of fingerprint maps currently enrolled for this
employee.

o Privilege: Select the desired terminal access privilege from the dropdown menu. The
choices are: Common User, Enroller, Supervisor, and Administrator. In order to update
the user privileges defined in Time Guardian, you must press the Send Maps button to
send this information to the terminal(s).

o Disable user from this terminal: Check this box to prevent this employee from having
access at this terminal (see figure above). In order to actually disable users at the
terminal(s), you must press the Send Maps button to send this information to the
terminals.

¢ PIN code: Shown with masked password [asterisks] when an employee has a password
with a statement on the bottom of the screen such as; "1 finger print map(s) and
Password available". This field can be used to change the employee's password at the
fingerprint terminal.

Note: The employee must have had a password originally created at the fingerprint terminal. If
no password exists for this employee you can not access this field.
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Deleting Employees

Selecting this option will display the following confirmation box:

i

@ Delete Employes Ledvina, Jeff 7

If you respond, “Yes,” the employee will be instantly removed from the database and cannot be
retrieved. A record of this action will be recorded in the Audit Trail Report for historical
reference.

2 X It is suggested that instead of deleting an employee, you can simply inactivate them by
selecting the Inactive box and a valid Inactive date at the bottom of the General tab of the
Employee Information module. This will allow you to keep a historical record of the
employee and not have them count towards your employee total.

Editing Employees

To edit an employee, select the Employee option from the dropdown menu. The same screen
for adding employees will appear, and the fields will be populated with employee information.
Once open, make the desired edits and close the menu. The information contained in the
“General” information tab can be printed using the Employee Report. For more information on
printing this report, please refer to the section on: Reporting Functions.

2% Double-clicking on a highlighted employee can also open the Employee Information screen.

Loading Employees

If you want to load employee(s) information from your data, click Yes to the question, Would
you like to Load all employees information? If No is selected, only the last employee selected
prior to closing Time Guardian will have their hours and exceptions updated with the latest
information each time the software is opened. If Yes is selected, Time Guardian will calculate
hours and exceptions for all employees. The difference is your preference in time, when Yes is
selected their may be a slight time delay while Time Guardian updates each record before
opening. If No is selected, Time Guardian will have to update each new employee as they are
selected from the employee list.

Clock Tab (Communication Settings)

This option allows you to add or edit terminal(s) and configure terminals. To access this
module, select the Setup menu from the main menu, and Wizard submenu, or click the Wizard
icon on the Custom Toolbar and select the Clock tab. The following is an example of the basic
clock setup module:
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To configure terminals connected to the system, click on the | button, and the
Communications settings screen will appear. If you are configuring a networked Ethernet
terminal, obtain the correct IP address from your network administrator to enter the IP address
in the Location tab screen.

Location Tab - Clock

A Location tab on the Communication Settings screen enables Time Guardian to communicate
with your terminals. Only one terminal type can be used per Location. If you have more than
one terminal type, you must configure multiple Locations.

]

To create a new Location, click on the New Location button, and enter the following:

e Location Name: Enter a unique name that will be used to describe the area or site where a
terminal or a group of terminals is located.

e Terminal Type: Select the terminal you are using. The choices are: MTX-5 (previous Time
Guardian), HandPunch 50e/1000/1000e/2000, HandPunch 3000/3000e, or RSl HandPunch
4000 (can use other HandPunches but must use a similar predefined one as a template),
MTX-15, and FINGERPRINT-T4.
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Connection Type: If you answered, “Yes” to the question, “Do you have Terminal(s) other
than direct-connect MTX?, FINGERPRINT” in the Clock tab of the Wizard, you must
configure those terminals for remote operation. Active MTX-15 (Time Guardian),Fingerprint,
or HandPunch terminals can communicate with your PC via a direct connection (RS-232C
or RS-485C), remotely using the optional modem (not fingerprint), or via Ethernet (network)
connections (IP address required).

Note: It is not recommended to mix the MTX-5 and the MTX-15 terminals on the same

communication line.

If you selected a Connection Type of Direct, you must complete the following:

Time Zone Offset: This should be used if your PC and the Location (terminals) are located
in different time zones. The default value is 0:00. Use the dropdown lists to configure the
offset.

Com Port:; Select the Com Port of the PC that will communicate with the terminals.

Active: When checked, the Location will begin sending and receiving data.

If you selected a Connection Type of Modem, you must complete the following:

Phone Number: The telephone number of the terminal’s modem. (Include 1 + (Area Code)
+ 7 digit phone number, when applicable).

Device Name: The name/manufacturer/type of the modem installed on your PC that will be
used to communicate with the terminal.

Max Attempts: The maximum number of attempts to successfully connect to the terminal.

Retry Wait: The time interval (in seconds) to connect to the terminal after an unsuccessful
attempt.

Time Zone Offset: This should be used if your PC and the Location (terminals) are located
in different time zones. The default value is 0:00. Use the dropdown lists to configure the
offset.

Com Port:; Select the Com Port of the PC that will communicate with the terminals.

Active: When checked, the Location will begin sending and receiving data.

If you selected a Connection Type of Non-Hayes (Modem), you must complete the following:

Phone Number: The telephone number of the terminal’'s modem. (Include 1 + (Area Code)
+ 7 digit phone number, when applicable).

Time Zone Offset: This should be used if your PC and the Location (terminals) are located
in different time zones. The default value is 0:00. Use the dropdown lists to configure the
offset.

Com Port: Select the Com Port of the PC that will communicate with the terminals.

Active: When checked, the Location will begin sending and receiving data.

If you selected Network as the Connection Type, enter the IP Address in the spaces provided.

IP Address: The IP Address of the terminal(s). May have to obtain from network
administrator. Also, see appropriate Terminal Installation manual (i.e., MTX-15 Installation
Manual) for Ethernet configuration.
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¢ Time Zone Offset: This should be used if your PC and the Location (terminals) are located
in different time zones. The default value is 0:00. Use the dropdown lists to configure the
offset.

o Active: When checked, the Location will begin sending and receiving data.
To clear any information entered, click on the Cancel button. This will reset the fields.

After you entered the correct information, click on the Save button. The Location Name will
appear in the Location List.

To delete a Location, select the desired Location from the Location List and click on the Delete
button. A message will appear to confirm your selection.

To exit the Communication Settings dialog, click on the Close button.

MTX Commands Tab - Clock

This tab allows you to perform the following functions with MTX-5 Time Guardian terminals:

o Polling: This operation collects the most recent data from the terminal. When checked,
Time Sync. performs time synchronization between the Host PC and the terminal including
Daylight Saving settings.

o Download: Sends Daylight Saving Time settings, employee assignments and Bell and
Door Schedules to the terminal.

¢ Auto Update: Performs the following functions:
— Confirms that the clock and the Host PC are communicating
— Assigns a terminal number
— Sends Daylight Saving Time settings
— Sends the Door Access and Bell Schedule

— Sets the time display of the terminal according to the PC settings
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¢ Initialize: This function will reset the terminal back to factory settings and clear the memory.
It is recommended that you wait one minute between performing this operation and
punching at the terminal.

o Memory Dump: Uploads all the punch data currently at the terminal to the PC and resets
the memory pointer to the start. This function is useful should there be a catastrophic data
loss.

Warning: If this function is performed with active data, duplicate punches may be created.

The Command Options dialog box allows you perform these operations on either the Selected
terminals, All Terminals or All Locations.

MTX-15 Commands Tab - Clock

This tab allows you to perform the following functions on MTX-15 Time Guardian terminals:

¢ Polling: This operation collects the most recent data from the terminal. When checked,
Time Sync. performs time synchronization between the Host PC and the terminal. This
includes Daylight Saving Time settings.

o Download: Sends Daylight Saving Time settings, employee assignments and Bell and
Door Schedules to the terminal.

e Auto Update: Performs the following functions:
e Confirms that the clock and the Host PC are communicating
e Assigns a terminal number
e Sends Daylight Saving Time settings
e Sends the Door Access and Bell Schedule
e Sets the time display of the terminal according to the PC settings

e Memory Dump: Uploads all the punch data currently at the terminal to the PC and resets
the memory pointer to the start. This function is useful should there be a catastrophic data
loss.
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Warning: If this function is performed with active data, duplicate punches may be created.

The Command Options dialog box allows you perform these operations on either the Selected
terminals, All Terminals, or All Locations.

Fingerprint Commands Tab — Clock
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This tab allows you to perform the following functions with fingerprint terminals:

e Polling: This operation collects the most recent data from the terminal (i.e., fingerprint
templates). When checked, Time Sync. performs time synchronization between the Host
PC and the terminal including Daylight Saving settings.

o Download: Press the :l button to send time, Daylight Saving Time settings, hours
worked, and employee assignments. The hours worked will be retained at the terminal from
the date of the last download for up to 14 days. If no new download occurs within 14 days,
the hours worked will not appear after 14 days.

Biometric Maps: The terminal must be polled before performing the following operations.
Polling the terminals will save biometric fingerprint templates for newly enrolled employees,
automatically update the database with templates for employees who have punched at the
terminal, and create terminal assignments for employees that have not yet been enrolled in the
database.

Note: If a newly enrolled employee does not exist in the employee database, then the template
in the terminal will not be saved. If the template data is inadvertently lost, it must be
reassigned to the terminal through the Assignments tab.

Each time an employee punches at the terminal, their fingerprint template will automatically be
updated in the employee database with the most recent template from the terminal. This feature
is for maintaining accurate fingerprint templates. However, if the employee does not exist in the
employee database, then a message will be displayed in the message window at the bottom of
the tab.

Once an employee is added to the Employee database, their template will not automatically be
uploaded unless the employee is removed and re-enrolled at the terminal, or a punch is
received from the terminal. Once this is done, however, the employee’s template will be saved
and an assignment will automatically be created.
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Send Maps: This command will download biometric fingerprint templates from the
employee database to the selected terminals. Only templates assigned to the terminals will
be downloaded. Employees are assigned to terminals in the Assignments tab, or by polling.
Because the download operation consists of first clearing all templates from the terminal
and then downloading assigned employee templates, a confirmation dialog box will appear
before this command executes.

Receive Maps: This command will upload employee templates from the selected terminals
and save them in the database. Only templates assigned to the terminals will be uploaded.
Employees are manually assigned to terminals in the Assignments tab.

Clear Terminal Maps: This will clear (delete) all employee templates from the selected
terminals. A confirmation dialog box will appear before this command executes to prevent
the unwanted deletion of employee templates. Click on the Yes button to continue or No to
cancel the operation.

HP Commands Tab — Clock

This tab allows you to perform the following functions with HandPunch terminals:

Polling: This operation collects the most recent data from the terminal. When checked,
Time Sync. performs time synchronization between the Host PC and the terminal including
Daylight Saving settings.

Download: Sends Daylight Saving Time settings, employee assignments and Bell and
Door Schedules to the terminal.

Biometric Maps: The terminal must be polled before performing the following operations.
Polling the terminals will save biometric hand templates for newly enrolled employees,
automatically update the database with templates for employees who have punched at the
terminal, and create terminal assignments for employees that have not yet been enrolled in the
database.

Note: If a newly enrolled employee does not exist in the employee database, then the template

in the terminal will not be saved. If the template data is inadvertently lost, it must be
reassigned to the terminal through the Assignments tab.

Each time an employee punches at the terminal, their hand template will automatically be
updated in the employee database with the most recent template from the terminal. This feature
is for maintaining accurate hand templates. However, if the employee does not exist in the
employee database, then a message will be displayed in the message window at the bottom of
the tab.
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Once an employee is added to the Employee database, their template will not automatically be
uploaded unless the employee is removed and re-enrolled at the terminal, or a punch is
received from the terminal. Once this is done, however, the employee’s template will be saved
and an assignment will automatically be created.

Send Maps: This command will download biometric hand templates from the employee
database to the selected terminals. Only templates assigned to the terminals will be
downloaded. Employees are assigned to terminals in the Assignments tab, or by polling.
Because the download operation consists of first clearing all templates from the terminal
and then downloading assigned employee templates, a confirmation dialog box will appear
before this command executes.

Receive Maps: This command will upload employee templates from the selected terminals
and save them in the database. Only templates assigned to the terminals will be uploaded.
Employees are manually assigned to terminals in the Assignments tab.

Clear Terminal Maps: This will clear (delete) all employee templates from the selected
terminals. A confirmation dialog box will appear before this command executes to prevent
the unwanted deletion of employee templates. Click on the Yes button to continue or No to
cancel the operation.

Advanced Setup: This dialog box enables you to remotely set the following parameters of
HandPunch terminals: This dialog can be used with one or more selected terminals.

RSI Hand Punch Advanced Setup x|
Hel =
Location/T erminal List P |
Service: I‘I
Setup: |2
Management: I3
Enrollment: I4
Special: I5
i Other Options
Access Tries: IE 5‘
|0 Length: noz
Rejzct Threshald: I‘I E 3’

Passwords: This box allows you to assign an Authority Level or Command Mode Group to
the employee. These groups allow access to commands in the RSI HandPunch for
employee enrollments, system management, and service operations. Refer to the
HandPunch documentation for more detailed information.

Command Mode Group Description
None No Command Mode Group.
Service Access to service and diagnostic functions.
Setup Set the baud rate and number of the terminal.
Management General system management operations.
Enrollment Enroll and remove users.

Allows people who are unable to use the Hand Punch
because of a disability or other infirmity to be enrolled.
Enrolling employees through this Command Group

disables the hand reading checks in the Hand Punch.

Special
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e Access Tries: The number of times a user can attempt to use the terminal before being
rejected.

o ID Length: The field length of the User or Employee ID.

o Reject Threshold: The sensitivity of the terminal to the employee’s hand geometry. The
default value is 125, but it can be set to a value between 30 and 250. A lower number
indicates high sensitivity.

Terminal Tab - Clock

The Terminal tab is used to manually add or remove terminals in a Location, and assign Bell
and Door Schedules to terminals. Each terminal in an Location is defined by its terminal
number.

To add a terminal:

1. Click on the New D'| button.

Select a Location from the Location List

Enter the terminal number in the Terminal Number field. The terminal number is the same
as the address assigned to the terminal during installation. Valid values are 1 through 31.
Each location may have up to 31 terminals connected together in a “daisy chain”. Refer to
your terminal’s specific documentation for assigning addresses and network connections.

Note: Terminal number MUST BE '0" for HandPunch Ethernet terminal.

4. If you wish to assign a Relay or Door Schedule to a terminal, select one from the dropdown
list.

5. Click on the Save button. The terminal number will appear in the Terminal List and a
terminal icon will be placed underneath the Location in the Location List.
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Note: Time Guardian terminals can be automatically added to a Location by selecting the Auto
Update command in the MTX or using the MTX-15 Commands tab.

To change or delete a Relay or Door Schedule, select a terminal from the Terminal List and use
the dropdown menu to assign a different schedule. Select a blank schedule to delete the
schedule. When finished, click on the Save button.

To delete or remove a terminal, select a terminal from the list and click on the Delete button,
and a confirmation message will appear.

Assignments Tab - Clock

The Assignments tab is used to manually assign employees/users to a terminal or a group of
terminals. If employees’ records already exist in the database, polling a terminal will
automatically create employee terminal assignments.

|

MTX.C o I HP C o |MTX 151G d | Location List:

Location | Terminal  Assignments :Z::au\l

Mo, Badge Mo. Employee Mamz

Clear Display

|

-]

The Assignments tab consists of Locations/Terminals and Employees lists. The
Locations/Terminal list displays all the Locations in the system and their terminals. Selecting
one or more of the terminals allows the user to assign employees to the selection. When a
terminal is selected, the employees assigned to it will be displayed in the Employees window. If
multiple terminals are selected, only those employees common to all selected terminals will be
displayed.

Creating and Assigning Door Access and Bell Schedules

Door Access and Bell Schedules can be created from the Setup wizard. However, a schedule
can only be assigned and downloaded when Time Guardian detects a clock. Select “Yes” to the

guestion “Do you want to create door access or bell schedules?” and click on the Bells
icon to open the module. This module allows you to create both Door Access and Bell
Schedules, however, only one schedule can be assigned per terminal. Once the schedule has
been created and assigned, the last step is to select Communication from the Main Menu, pull
down and select submenu MTX and HandPunch, and Downloading. This will automatically
download the new schedules to the assigned terminals.

The following example displays a split screen with a Door Schedule to the left and a Bell
Schedule to the right. In both cases, you begin by assigning a schedule name in the Name
field. Next, select the type of schedule: Door or Bell.
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e A Door schedule requires you to enter the amount of time a door will remain open after
each swipe. This is entered in the Relay Duration field.

o A Bell schedule requires you to enter the duration, time of day, and weekly schedule for the
bell to ring. Multiple entries can be made for Bell schedules with different duration and day
assignments.

Relay Schedule

0] & =|

Fickay Event Setting ] Assign Relay Scheduls ]

Relay Schedule List

Mame  ||Fire-Alarm

+ Door

" Bell

Felay Duration 0500

|

Once all schedules have been created and saved, the “Assign Relay Schedule” tab will become
active. This tab is divided into two sections. To the left, the Relay Name list contains all of the
schedules. To the right, the Terminal Number List contains all terminals currently active in the
system as shown in the following example:

To assign a schedule to a terminal, highlight the schedule name and select the Assign button.
That schedule will then appear under the terminal. To remove an assigned schedule, highlight
the name under the terminal and hit the delete key on the keyboard.

Advanced Setup Wizard Login Tab (Profile Definition)

There are three possible levels of Access Rights, controlled by the two check boxes marked
Administrator and Read-Only. The following describes the access rights given to users based
upon checkbox selection:

¢ Administrator Checkbox selected: Grants the full ability to add, modify and edit any data
contained in the system, including all employee and Time Guardian user login data.
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o No Checkboxes Selected: The user has the same access as an Administrator with regard
to employee data, but cannot access or modify the Time Guardian user login data.

e Read-Only: Can view all data in the system but cannot modify any data or add any new
data.

Note: During Advanced Wizard setup at least one Administrator profile should be created.

Additional Profiles can be added, and existing Profiles can be modified using three different
methods:

1. Open the Login Profile module. This can be done by using either of the three following
methods:

a. 1% method: Selecting Setup from the Main Menu, and clicking the Login Profiles
submenu.

b. 2" method: Selecting Setup from the Main Menu, and clicking the Wizard submenu.
From the Setup Wizard screen click the Login tab, and then click on the Login

Information button and the Login Profile screen will appear.

K

c. 3" method: Clicking on the Wizard icon in the Custom Toolbar to display the Setup
Wizard screen, selecting the Login tab, and then click on the Login Information button
and the following Login Profile screen will appear:

2. From the Login Profile screen (as illustrated above) click on the button. From

the Login Profile menu, you must select “Add” before a new Profile can be created, and the
following “Add New Profile” window will appear:

Add New Profile 3]

User Profile I Advanced Paseword }

Narng: W
Password: ,,‘—
Canfirm Password: ,m—
Language: m

W daministrsior r

Enter the Name of the user (see screen above on right).

3

4. Enter and confirm the password.

5. Select Language from drop down menu.
6

Select if the profile will have Administrator or Read Only access. Press the Save button.
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7. Select the “Advanced Password” tab to configure password expiration options and the
following screen will appear:

8. When finished, the new profile will be created and added to the Authorized Users list.
Highlighting a name on the list and selecting the “Default User” box will make that user the
default name and it will appear each time the software is opened.

2% All Profiles are case and space sensitive. If you have a problem accessing the software,
confirm the login information and try again.

Payroll Interface Creation

Time Guardian currently provides interfaces to the following payroll software companies: ADP
for DOS, ADP for Windows, Excel, QuickBooks, Peachtree, Power Pay, Paychex Paylink,
Paychex Preview, CBS Payroll, GevityHR, and PAYDAY of AMERICA. If selected during the
initial Setup Wizard, the Payroll Interface will be displayed at the bottom of the Report List.
Clicking on the Payroll Interface will display the Payroll software selected from the Setup
Wizard. Only one Payroll company can be used at a time. Select Setup from the main menu,

=

pull down to the Wizard submenu. From the General tab view, click on the icon to display
the Payroll Software selection screen to change your selection. Each payroll company has a
different setup process, which are detailed in the following paragraphs.

Note: If QuickBooks was selected as your Payroll software, Time Guardian will integrate
directly to QuickBooks. QuickBooks must be installed on the same PC as Time
Guardian and open during installation. Upon completion of Time Guardian Wizard
setup, QuickBooks will download up to 100 employees. Time Guardian can be
synchronized at any time with QuickBooks by issuing the "Sync Employee(s) with
payroll" command.

To perform payroll setup process:

1. Press Payroll Interface in the Reports/Payroll Interface view (left-hand side). See the
following figure for an example.
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2. Click on the Payroll icon when it appears in the top left-hand window (see the following
figure for an example).

3. Navigate through the payroll pages icon when it appears in the top left-hand window (see
the above figure for an example). The following sections detail the setup process for payroll
pages 1 thru 4 information for each payroll system.

Power Pay

The setup process to create an export file for Power Pay is as follows:

1. Select Yes or No for the question; Do you want to import the Company Information?.

2. If Yes, choose the location and file name of the export file. This information is entered in the
select path field.

Example: C:\ProgramFiles\Time Guardian\Export.txt.

3. Visit Http://mww.PowerPay.com on the web and download the required PDM information.
This will create a file named “today’s date”pdm.txt.

Example: 12-12-2000pdm.txt
The breakout of this file is as follows:

001, 24034 (Company Number), 001(Site Code), 12(Sequence Number) 002,809,D2, Direct
deposit fixed.

3. Enter the Company Number. This can be found in the second section of the PDM
information as displayed in step 2.

4. Enter the Site Code. This can be found in the third section of the PDM information as
displayed in Step 2.

Enter the Pay Period start date. This is the date on which this Pay Period begins.
Enter the Payroll end date. This is the date on which the Pay Period ends.

Enter the effective check date. This is an optional field that represents the date printed on
the check.

Run # for information purposes only.

Select how hours for Time Guardian are to be transferred to Power Pay. Assigning a Payroll
Field ID to the Pay Codes in Time Guardian does this, and the Power Pay payroll field IDs
are located in the PDM file. The payroll field id is the number after the first comma for any
line that begins with 002.
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Example:

Time Guardian Pay Code

Power Pay Payroll Field ID

REG 1307
HOL 1304
oT 1270

9. From page 5 of 6, select the employees to be included in the payroll file. Your options are:
o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be

included in the payroll file.

o Selected: Only the employee displayed in the Employee List box will be included in the

payroll export file.

10. The last screen (pg 6 of 6) shows a summary of the information contained in the payroll

export file.

11. Select the Save Payroll Settings icon and then select the Run Payroll

generate the export file.

Peachtree

icon to

The setup process to create an export file for Peachtree is as follows:

1. The Ticket number is for informational purposes only.

2. Choose the location and file name for the export file. This information is entered in the select

path field.

Example: C:\ProgramFiles\Time Guardian\Time.cvs

3. Select how hours for Time Guardian are to be transferred to Peachtree. Assigning a Payroll
Field ID to the Pay Codes in Time Guardian does this. Peachtree payroll field IDs are 1 for

straight time and 2 for time and a half.

Example:
Time Guardian Pay Codes Peachtree Payroll Field ID
REG 1
HOL 1
VAC 1
SCK 1
oT 2

4. From page 3 of 4, select the employees to be included in the payroll file. Your options are:

o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be

included in the payroll file.
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¢ Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.

5. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

6. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.

QuickBooks

The setup process to create a QuickBooks export file manually is as follows:

1. From the main menu of QuickBooks select File (see figure).

2. Select Utilities => Export => Timer Lists and the following screen will appear:

3. Enter the name for the payroll file in the File name field (see figure). It is recommended to
use a .iif file extension.
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4. After the file has been saved, open the file using Notepad (see figure). Information from this
file will be used to create the export file from Time Guardian.

5. From Time Guardian, click on the Payroll Interface button to display the
QuickBooks Payroll icon. Click on the QuickBooks Payroll icon and page 1 of 4 for the
QuickBooks setup screen will appear. You must not select the checkbox option
QuickBooks hours integration and the following screen will appear to enter the
information obtained from the QuickBooks file in step 4. Generate hours by day will be
selected by default.
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6. Enter the version number of the QuickBooks package you are using. This information can
be obtained from QuickBooks iif file opened with Notepad in step 4 (see figure).

7. Enter the release number of the QuickBooks package you are using. This information can
be obtained from QuickBooks iif file opened with Notepad in step 4 (see figure).

8. Enter the Company Name from QuickBooks. This information can be obtained from
QuickBooks iif file opened with Notepad in step 4 (see figure).

9. Enter the Create Time number from the QuickBooks package you are using. This
information can be obtained from QuickBooks iif file opened with Notepad in step 4 (see
figure). Time Guardian will enter a default value in the Export To field. Choose the location
and file name for the export file. This information is entered in the select path field.

10. Once all the fields have been entered on page 1 of 4, click on the blue arrow to move to
Page 2 of 4 (see figure) and select the Pay Codes that you want transferred from Time
Guardian to QuickBooks. Assigning a payroll ID to the desired pay codes will do this. A
complete list of payroll Ids can be found in QuickBooks payroll items.

Example of TG Pay Codes vs. QuickBooks Payroll Field IDs:

Time Guardian Pay Codes QuickBooks Payroll Field ID
REG Regular Pay
HOL Holiday Pay

11. From Time Guardian, click on the blue arrow to display Page 3 of 4 (see figure), and select
the employees from the Available List to be included in the payroll file. The options are:

o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.
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12. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

13. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.

14. Once the export file has been created from Time Guardian it can now be imported by
QuickBooks. From QuickBooks select File from the main menu (see figure).

15. From QuickBooks Pro, select Utilities =>Import => Timer Activities and the following
QuickBooks screen will appear:

16. Select OK to continue and select the file to be imported (see figure). This is the file name

that was defined in Time Guardian. Highlight the file as illustrated in the example figure and
select open.
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17. From QuickBooks view the imported employee information, create paychecks if desired,
and/or submit for payroll.

QuickBooks Auto Integration with Time Guardian

Note: For auto synchronization to work: QuickBooks Pro version 7 or higher must be installed
on the same PC as Time Guardian. Also, QuickBooks Pro must be started up first and
running before starting up Time Guardian.

QuickBooks Pro must be selected as your Payroll software. From the setup Advanced Setup
Wizard General tab, select Yes for; Do you want to send employee hours to your payroll

software? (see figure), and click the Payroll Software icon. Select QuickBooks from the
Payroll Software list and press Save.

The following procedure describes how to setup Time Guardian for QuickBooks Pro auto
integration/synchronization.

1. From Time Guardian, click on the Payroll Interface | | button to display the
QuickBooks Payroll icon (see the following figure).
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2. Click on the QuickBooks Payroll icon and page 1 of 4 for the QuickBooks setup screen will
appear (see the following figure). You must select the checkbox option QuickBooks hours
integration and to Generate hours by day will be selected by default. If you do not want
entries to be duplicated when transferring an employee, select the Overwrite duplicate
payroll entries.

3. Navigate to page 2 of 4 for the QuickBooks setup screen to display the Paycode setup (see
the following figure). In the Paycode setup screen, you must map each of the fields in Time
Guardian to the appropriate field in QuickBooks. Select from a list of QuickBooks entries by
clicking on a QuickBooks icon to the right of the fields.

Note: QuickBooks (only version 7 or higher will auto sync) must be installed and on the same
PC as Time Guardian, and started running before Time Guardian. If it is not, you will be
notified with a warning message when synchronization is attempted.

4. When you click on a QuickBooks icon the QuickBooks Paycode screen will appear (see
figure). Map the QuickBooks Paycodes to the desired Time Guardian Paycodes and click
OK. These paycodes must have first been setup in QuickBooks!!
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Note: QuickBooks should have pay rates setup for Time Guardian to synchronize to.

5. From page 3 of 4, select the employees to be included in the payroll file (see figure). Your
options are:

o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

o Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.

6. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file (see figure).

7. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.

8. When Time Guardian attempts to synchronize employees or transfer payroll information to
QuickBooks, the following dialog will appear:
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9. In the selection that asks, Do you want to allow this application to read and modify this
company file? You must select Yes, always; allow access even if QuickBooks is not
running. Also, the check box at the bottom of the dialog captioned; Allow this application to
access personal data such as Social Security Numbers and customer credit card
information must be checked as Time Guardian appends/modifies personal data (employee
information, payroll entries).

Note: If this is not setup correctly, Time Guardian will fail to synchronize employees and
payroll information.

QuickBooks Synchronization

From Time Guardian, click on the Employee menu, and select Sync Employee(s) with
Payroll. A warning dialog box will appear if QuickBooks is not running.

An alternate method would be to click on the Setup menu, and select the Wizard sub-menu.
Select the Employee Tab from the Setup Wizard screen (see figure) and click in the box
alongside Sync Employee(s) with Payroll.
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QuickBooks Compatibility

Note: Time Guardian is compatible with QuickBooks 2007 or higher for automatic integration.

Time Guardian is compatible with the following versions of QuickBooks for manual export:
e QuickBooks 2007 and Enterprise 7.0

e QuickBooks 2006 and Enterprise 6.0

o QuickBooks 2005 and Enterprise 5.0 (R5 and later)

o QuickBooks 2005 and Enterprise 5.0

e QuickBooks 2004 and Enterprise 3.0 (R7 and above)

e QuickBooks 2003

e QuickBooks 2002 (R2 and above)

e QuickBooks 2002

Excel

The setup process to create an export file for Excel is as follows:

1. Select whether or not to:
Show employees with no hours
Separate records by day
Pass wages

2. Enter the Payroll Number from the dropdown menu. Your choices are: Employee Number,
Badge Number, or Social Security Number.

2. Enter the Date Format from the dropdown menu. Your choices are: MM/dd/yyyy,
yyyy/MM/dd, or dd MM yyyy.

3. Enter the Hours Format from the dropdown menu. Your choices are: Hundredths, Minutes,
or Hours:Minutes.

4. Choose the location and file name for the CSV export file. This information is entered in the
select path field.

Example: C:\ProgramFiles\Time Guardian\ flename
5. Select the paycodes from the dropdown menus.
6. Select the employees to be included in the payroll file. Your options are:
e All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.

7. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

8. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.
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ADP For Windows

Note: ADP for Windows provides access to ADP "Pay Expert", which is ADP's web-based

assistant.

The setup process to create an export file for ADP for Windows is as follows:

1. You must specify your Company Code. For ADP, this is a three-character upper-case code
identifying the company that the payroll is for.

2. You must specify your Batch No. For ADP, this is a two-character upper-case code
identifying the batch no. that the payroll is for.

3. Choose the location and file name for the export file. This information is entered in the

select path field. Specify the drive and directory where ADP for Windows is installed on the
PC. The file name will be Extpay99.

Example: CAADP\ADPDATA\Extpay99

4. Select how hours for Time Guardian are to be transferred to ADP. Assigning a Payroll Field
ID to the Pay Codes in Time Guardian (page 2 of 4) does this. ADP uses categories for their

Hour Codes, they are as follows:

Hour Category Time Guardian Payroll Field ID
Equitant

Regular 012
Overtime 013

Hours 3 O016AA
Hours 3 017AA
Hours 4 018AA
Hours 4 019AA
Earnings Code 3* 020
Earnings Code 3* 021
Earnings Code 4* 022
Earnings Code 4* 023
Earnings Code 5* 024
Earnings Code 5* 025

*Used only if using Dollar Pay Codes in Time Guardian.

AA is a two-character identifier for categories other than Regular and Overtime. If it is only

one character, you must put a space before the character. The following table provides

examples of some of the possible Payroll Field ID's for ADP categories:

Time Guardian Pay Code ADP Category Time Guardian Payroll Field ID
Reg-Regular Regular 012

OT-Overtime Overtime 013

Vac-Vacation Hours 3 016_V, 016VA, 017_V, 017VA
Sck-Sick Hours 4 018_S, 018SC, 019_S, 019SC
Bon-Bonus Earnings Code 3 020, 021

Tip- Tips Earnings Code 4 022, 023
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5. ADP for Windows must be setup to accept the interface file from Time Guardian. This is
done by logging into ADP for Windows and selecting Setup|Company from the main menu.
Highlight the company name and click OK. A dialog box will appear at the bottom of the
dialog box.

6. Click on the tab that states “Page 2.” There should be a check box labeled Total Time or E-
Time. Click on the box to check it and Save changes.

7. Select the employees to be included in the payroll file (pg 3 of 4). Your options are:

o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.

8. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

9. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.

ADP For DOS

The setup process to create an export file for ADP for DOS is as follows:

1. You must specify your Company Code. For ADP, this is a three-character upper-case code
identifying the company that the payroll is for.

2. You must specify your Batch No. For ADP, this is a two-character upper-case code
identifying the batch no. that the payroll is for.

3. Choose the location and file name for the export file. This information is entered in the
select path field.

ADP DOS: Specify the drive and directory where ADP for DOS is installed on the PC. The
file name will be ExtpayO1l.
Example: C:\PCPERS\Extpay01

4. You must specify your Version No. For ADP, this is a one-numeric code identifying the
PC/Payroll and personnel version number.

5. Select how hours for Time Guardian are to be transferred to ADP. Assigning a Payroll Field

ID to the Pay Codes in Time Guardian does this. ADP uses categories for their Hour Codes,
they are as follows:
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Hour Category Time Guardian Payroll Field ID
Equitant
Regular 012
Overtime 013
Hours 3 016AA
Hours 3 017AA
Hours 4 018AA
Hours 4 019AA
Earnings Code 3* 020
Earnings Code 3* 021
Earnings Code 4* 022
Earnings Code 4* 023
Earnings Code 5* 024
Earnings Code 5* 025

*Used only if using Dollar Pay Codes in Time Guardian.

AA is a two-character identifier for categories other than Regular and Overtime. If it is only
one character, you must put a space before the character. Below are examples of some of
the possible Payroll Field ID's for ADP categories:

Time Guardian Pay Code ADP Category Time Guardian Payroll Field ID
Reg-Regular Regular 012

OT-Overtime Overtime 013

Vac-Vacation Hours 3 016 _V, 016VA, 017_V, 017VA
Sck-Sick Hours 4 018_S, 018SC, 019_S, 019sC
Bon-Bonus Earnings Code 3 020, 021

Tip- Tips Earnings Code 4 022, 023

6. Click on the tab in ADP that states “Page 2.” There should be a check box labeled Total
Time or E-Time. Click on the box to check it and Save changes.

7. Select the employees (pg 3 of 4) to be included in the payroll file. Your options are:

o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be

included in the payroll file.

o Selected: Only the employee displayed in the Employee List box will be included in the

payroll export file.

8. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll

export file.

9. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.
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Paychex PayLink

The setup process to create an export file for Paychex PayLink is as follows:

1.
2.

The Version number is for informational purposes only.

Enter the Site Number for Paychex.

Example: Site Number: 001

Enter the Office Number for Paychex. This range is from 0001 to 1295.
Enter the Client Number for Paychex. This is a four-character number.
Enter the Sequence Number for Paychex.

Example: Sequence Number: 000

For Save To: choose the location and file name for the export file. This information is
entered in the select path.

Example: C:\Paylink\Import

Select how hours for Time Guardian are to be transferred to Paychex. Assigning a Payroll
Field ID to the Pay Codes in Time Guardian does this. Paychex uses two codes to identify
Hours: Pay Type and Hours Type.

o Pay Type identifies hours as Salary, Rate 1, Vacation and Sick.
e Hours Type identifies hours by Regular (straight pay) or Overtime (time and a half pay).

The combination of the Pay Type and Hours Type form the Payroll Field ID. Below is a list of
the Pay and Hours types:

Pay Type Name Pay Type Hours Type Name Hours Type

Salary SA Regular Hours 0A

Rate 1 R1 Overtime Hours 0C
Rate 2 R2
Rate 3 R3
Non-Qualified Sick Pay NS
Qualified Sick Pay QS
Vacation VA
Holiday HO
Miscellaneous M

The following are some examples of possible Payroll Field ID’s for Paychex.
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Pay Code Description Field ID

REG Rate 1 Regular Hours, Rate 2 Regular Hours, Rate 3 Regular Hours RloééE:OA’

Rate 1 Overtime Hours, Rate 2 Overtime Hours, Rate 3 Overtime R10C, R20C,
oT

Hours R30C
SCK Qualified Sick Regular Hours, Non-Qualified Sick Regular Hours QSO0A, NSOA
HOL Holiday Regular Hours HOOA
VAC Vacation Regular Hours VAOA
MSC Miscellaneous Regular Hours MIOA

8. Select the employees to be included in the payroll file. Your options are:
o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.

9. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

10. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.

Paychex Preview

The setup process to create an export file for Paychex Preview is as follows:

1. Enter Client number (Maximum of 6 digits).
2. Select the file path. (Where the file is to be created).
3. Select if you want to generate hours by day.
4. Enter payroll ID Use a two character code, the first character is an E.
Example: Reg=1 the payroll ID for this Pay Code would be E1.
5. Select the employees to be included in the payroll file. Your options are:
e All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.

6. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

7. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.
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CBS Payroll

The setup process to create an export file for CBS Payroll is as follows:

1. Enter Company Code.

2. Enter the File Name.

3. Browse to and enter the File Location.
4

Enter Payroll IDs for each Pay Code being used. The Payroll Field ID is a maximum of 4
digits and consists of the following:

¢ N-Normal Hours
e V-Vacation Hours
e H-Holiday Hours
e S-Sick Hours
In the second position, select which area to categorize the hours:
o 1-Regular Hours
e 2-Overtime Hoursl
e 3-Overtime Hours2
e 4-Overtime Hours3
5. Select the employees to be included in the payroll file. Your options are:
o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll file.

6. The last screen (pg 4 of 4) shows a summary of the information contained in the payroll
export file.

7. Select the Save Payroll Settings icon and then select the Run Payroll icon to
generate the export file.

GevityHR

The setup process to create an export file for GevityHR is as follows:

1. Enter Company Number (Code) from information provided by GevityHR.
Enter the File Name from information provided by GevityHR.

Browse to and enter the File Location.

Select Payroll IDs from the dropdown box for each Pay Code being used.

a M w DN

Select the employees to be included in the payroll file. Your options are:
e All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be
included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the
payroll export file.
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The last screen (pg 4 of 4) shows a summary of the information contained in the payroll

export file.

Select the Save Payroll Settings
generate the export file.

PAYDAY of AMERICA

icon and then select the Run Payroll

icon to

The setup process to create an export file for PAYDAY of America is as follows:

1.

a s oD

Enter Company Number (Code) from information provided by PAYDAY of AMERICA.
Enter the File Name from information provided by PAYDAY of AMERICA.

Browse to and enter the File Location.

Select Payroll IDs from the dropdown box for each Pay Code being used.
Select the employees to be included in the payroll file. Your options are:
o All: Every employee entered in Time Guardian will be included in the payroll file.

e Current: Only the employee currently highlighted in the Employee List box will be

included in the payroll file.

e Selected: Only the employee displayed in the Employee List box will be included in the

payroll export file.

The last screen (pg 4 of 4) shows a summary of the information contained in the payroll

export file.

Select the Save Payroll Settings
generate the export file.

icon and then select the Run Payroll

icon to
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Chapter 5: Time Guardian System Backup

Time Guardian provides an automatic backup that can be activated at the time of installation or
added at a later date by selecting the Setup menu from the Main menu, and selecting the
Wizard submenu. From the Setup Wizard click the Login tab and click the Backup

Information Li#] jcon and the following Backup Information screen will appear:

General] Deparlmant] Pay F’ohcy] Pay Cadel Except\ons] Schedula] Emp\oyee] Clock  Login ]
Perzonal Login
Do pou want to create an automatic backup schedule?
£ Mo Backup Information EJ
(O
9 s HilLiil Select the day of the week to start your backup
Monday -
What is the number of historic backup files to be created?
L
Backup file lacation
|C.\Prugram FilesTime Guardian‘Backup %
X Cancel |
<< Previous ‘ Next »» ‘ o Finish | i'l_ Close | ? Help |

Backups are automatically created in the “Backup” folder located under the program directory
unless designated otherwise. Backup files are archived .zip format and can be extracted back
to the Time Guardian folder should corruption occur.

2% When the Time Guardian Backup is created on the local PC, it is advised that a copy of the
Backup be saved to floppy disk, network drive or another medium to protect against
catastrophic computer failure.

Each file will be named “backup”, along with the date the file was created.

As seen in the figure above, a Backup requires you to select the “Backup Start Day.” Your
options are: Sunday through Saturday. It also requires you to enter “Number of Backup Files to
be rotated.” This number is currently limited to twenty-five (25) files. From that day forward to
the first day of the next period, Time Guardian will automatically create a new Backup file. Time
Guardian will create seven files every week, each being overwritten until the last day of the
week.

Using the settings below, Time Guardian will create the first Backup on Monday and append
this record every time the software is opened, until the following Monday. A new Backup record
will then be created. This process will continue until seven weeks of Backup records have been
created. At this time, the next Backup to be created will replace the first Backup record
completely. The process will then repeat itself.
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Backup Information x|

Select the day of the week to start your backup

I Manday = l

What is the number af historic backup files to be created?

|1 Ev

B ackup file lozation

IE: “Program FileghTime Guardian®B ackup EI

X Cancel |

In the case above, the Backup folder will contain a maximum of seven files. This Backup
process was specially designed to ensure that a corrupted file could not contaminate the entire
Backup process. Should further assistance be needed, please refer to the Time Guardian
Support section of this Guide for direct support options.
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Chapter 6: Reporting Functions

Time Guardian includes nine (9) different reporting options: Department, Employee, Time Card,
Presence, Audit Trail, Hours Worked, Exception, Hours Summary, and Historical Report. These
reports are listed in the left hand column of the Main window and can be rearranged by left
mouse clicking on the report icon and dragging the icon to the desired location.

Left mouse clicking once on the report icon generates a report that will be displayed in the
Report View section of the Main window. Reports can only be generated for the Pay Period
displayed in the “Grid View Selection Options”. The cumulative reporting is the same as
historical reporting in Time Guardian. To produce a cumulative history, a report must be run for
each Pay Period. There is, however, a Historical Report Settings module (see Historical Report
for more detailed information) that will allow you to run reports based upon a specific date
range. For more information about on reporting, please contact: TGSupport@Amano.com

Report appearances will vary depending on the criteria selected during the setup. To display a
Report for a specific employee, highlight the employee in the Employee List section, and drag
the employee record to the Report View section. This action will cause the selected employee
information to be displayed. However, a report must be visible for this to work. To view multiple
records in a Report, click on the scroll bar using the up or down arrows or use the “PgUp” and
“PgDn” keys on your keyboard.

How employees are listed on reports is based on the selection made in the Sort By.... Option in
the employee administration area. The default is Employee Number, and your other options
are: Badge Number, Last Name, First Name, and Department. When department is selected,
employees will be listed by their department and sorted by their employee number.

Printing and Closing Reports
Reports can be printed using three different methods:
e 1% Method: Select the Print option from the File Menu in the main menu.

e 2" Method: Right mouse click in the Report view section of the Main menu to display the
drop down list. Select Print.

e 3" Method: The final option is only available if the Print icon has been added to the Custom
Toolbar. For instructions on how to customize the Toolbar, please refer to the section QS 1.:
Creating a Custom Toolbar.

Once the Print command has been selected, the Print command window will be displayed.
Select the printer for the Report, along with the page range and number of copies. The
following is an example of the print drop down list and the print command window:

P x|

Frinl
Mare: |8 \WPRINT_SERVER\HP LJ 5000N TechPub Se x| Propetties

Type: YSPRINT_SERVERAHP LJ 5000N TechPub Se
‘where:

—Page Range Copi

© Al Mumber of copies: |1 _Y_IZ
= Curent Page
" Pages I ¥ Collate
Enter page numbers and/or page ranges
separated by commas. For example, 1.3,5-12.
Frint IAH pages in range j
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Department Report

As seen in the following example, the Department Report will provide you with a list of
Departments by Number, Department Name, and Comments. If you have chosen not to create
Departments for your company, this report will be blank.

Department Report

Fortune Fish Company
3/24/2002 - 3/30/2002

44172002 16:05

MNumhber Department Name Comments

1 Operations Fillet

Operations Warehouse

Dalivary

Sales

M| &= | [k

Administration

Employee Report

As seen in the following example, the Employee Report provides a list of employees, including
all of the information contained in the General tab of the Employee Setup module.

Employee Report
Fortune Fish Company
3/24/2002 - 3/30/2002
4/72002 16:09
Acanfora, Lawrence W,
Humber 323425614 Badge Humber A3Z2342561
Department: #4 Sales
Schedule: Mo Schedule
Pay Class: Pay Policy #1
Pay Type: By Hours Humber of Hours E:]
Type: Salary
Hire date: 121072001 Active M Inactive date:
Birthday: 12M 472001
5.5. # 323-42-5614
Address: 9227 W, Cermack
Marth Riverside L
usa, G046
Telephone:
Comments:

Time Card Report

As seen in the following examples, the Time Card Report provides a complete and detailed
account of employees’ punch times, totals, wages, and exceptions for a specified period of
time. Information will vary based on your company’s Setup selections. Wages will only be
displayed if enabled to be displayed on reports on the Pay Code tab from the Setup Wizard.
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Without Wages Example

With Wages Example

Time Card Report

Fortune Fish Company
10:15/2007 - 10:21/2007

Wage
Information
10/23/2007 10:41 AM
Smith, John
Humber 1 Badge Humber #H0000H01
Date Schedule I Ourt 1) Out Pay code Wiage i Euql(ions
Won 101 S2007) 03.00 AM-0500PM | 08:00 AN | #5:00 PM FEG.E00 REG §126.0
Wion 104 52007 DT-§23 562
Wion 100 52007
Tue 10/ 62007 03.00 AM-0500FM | 03:00 AM | 85:00 PM REG 1 25,0
Tue 10/ 62007 oT-$52362
Wed 10/17/200] 0300 AM-0500PM | 08:00 AM | #5:00 PM REG-$126.0
e 1001712007 oOT-§2352
Wed 100172007
Thu 1011 22007 | 0200 AM-0S00FM% | 05:00 AM | #5:00 PM REG.$1 260
The 101 872007 OT.$2352
Fri 1001 552007 0300 AM - 0500 P 08:08 AM | #5:00 PM REG:H 250
Fri 10182007 / OT-$2352
= 000 $630.00

Tips & Bonus information 50 $118.90

will appear under the T 125.00

Paycode column -

Signature Date

Presence Report

As seen in the following example, the Presence Report provides a list of employees currently

punched IN at the terminal. This report will only be accurate if the terminal is polled regularly.
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Presence Report

Fortune Fish Company
3/31/2002 - 4/6/2002

47142002 16:13
Acanfora, Lawrence W,
Humber 323425614 Badge Humber A32342561
Schedule In Out In Out
Mone 08:00
Casalla, Renato
Humber 355703615 Badge Humber 000000004
Schedule In Out In out
2200P - 15300 0800

Audit Trail Report

As seen in the following example, the Audit Trail Report records every change made in Time
Guardian. This includes changes made to an employee’s punch, and the addition or deletion of
a Department, or any other modifications made to the program. This invaluable report also
provides the date, day and time the modification was made, including the Login name of the
user who made the change. Events will be listed in chronological order, starting with the first
edit and continuing through to the last, with a line separating activities for each date. This report
will record all punch transaction records and warnings of undefined data.

Audit Trail Report
Fortune Fish Company
3/31/2002 - 4/6/2002
44172002 16:14
Action Date Action Time Profile Description
Mon 4142002 09:50 Aaron User : Saron logged in
Mon 41,2002 10:05 Aaron Location: Default, Connected
Mon 412002 10:05 Aaron Location: Defautt, Connected
Mon 40142002 11:09 Aaron Al Mewy Punch = Sun §:00 = for employee: Xolio,Felipe added on 3/31/2002
Mon 4142002 11:09 Aaron Ao Mewy Punch = Sun 22200 = for employee: Xolio Felipe added on 3/31/2002.
Mon 41,2002 11:09 Aaron Add Mewy Punch = Man 08:00 = for employee: Casalla,Renato added on 4412002
Mon 412002 11:09 Aaron A Mewy Punch < Sun 10:00 = for employes: Casalla Renato added on 3531/2002
Mon 412002 11:10 Aaron Audel Mewe Punch = Mon 15:00 = for employee: ¥olio Felipe acdded on 3/25/2002.
Mon 40142002 11:10 Aaron Al Mewy Punch = Mon 07:00 = for employee: ¥olio Felipe added on 3/25/2002.
Mon 41,2002 1110 Aaron Add Mewy Punch = Sun 16:00 = for employee: Xolio Felipe added on 5/24/2002
Mon 41,2002 1110 Aaron Add Mewy Punch = Sun 0800 = for employee: Xolio Felipe added on 5/24/2002
Mon 412002 1011 Aaron Adl Mewe Punch = Tue 22:00 = for employes: Xolio Felipe added on 3/26/2002.
Mon 40142002 1011 Aaron Al Mewy Punch = Tue 05:00 = for employee: Xolio Felive added on 3/26/2002.
Mon 4142002 12:39 Aaron Pay code = HOL = walue modified from 0 to 07.00
Mon 41,2002 12:39 Aaron Pay code = BER > value modified from 0 1o 15:00
Mon 412002 14:39 Aaron Add Mewy Punch < Sun 08:00 = for smployee: Milkovic Husein added on 3724/2002
Mon 40142002 14:40 Aaron Acdel Mewy Punch = Mon 20:00 = for employee: ¥olio Felipe added on 3/25/2002.
Mon 4142002 14:40 Aaron Ao Mewy Punch = Mon 09:00 = for employee: ¥olio Felipe added on 3/25/2002.
Mon 41,2002 14:50 Aaron Pay code = TIPS = walue modified from $0 to 32.00
Mon 412002 16:13 Aaron Add Mewy Punch < Man 08:00 = for employee: Acanfora Lawrence added on 44 /2002

Hours Worked Report

As seen in the following example, the Hours Worked Report includes the Name, Employee
Number, and Badge Number, and provides a compact total of Wages and Hours/Dollars for
both the day and pay period, along with any adjustment comments. This report will display
Department totals when the employee list in the Hours grid is sorted by Department. Wages will
only be displayed if enabled to be displayed on reports on the Pay Code tab from the Setup
Wizard.
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Without Wages Example

With Wages Example

Exception Report

The flagging of Exceptions is a valuable piece of information that can be provided by Time
Guardian. These flags provide managers with a key piece of feedback as to when, how, and if
an employee is punching properly. If you did not choose to use Exceptions during the initial
installation, they can be modified at any time by opening the Wizard and selecting the
“Exceptions” tab. Select the exceptions you wish to track [see below for additional method].
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As seen in the following example, the Exception Report includes the Name, Employee
Number, and Badge Number. It provides a list of the Exceptions that were generated based on
the settings selected in the Exceptions section of the Wizard. The report also includes reasons
provided in the Main operations window. Employees may have multiple Exceptions for the
same day, depending on the settings provided. If no exceptions were selected during the setup
Wizard, then this report will be blank. To add additional exception codes to your system, refer to
the section about the Exception Tab.

Exception Report

71772006 - 7/30/2006

8/8/2006 0749 A

Paxton, Jeffrey Thomas
Humber 1001 Badge Humber 000000101

Date Exceptions Reasons

Tue 71872006 WP ( Missing Punch 1 Died not have bacge and could not punch in.
Wed 719/2008 El {EarlyIn)
EC ( Early Qut )

By default, all Exception codes are selected during the setup wizard and are included in the
report. Alternatively, to modify the exceptions displayed, right click on the Exception Report

icon and a list of available exceptions will be displayed in the following Exception for
Report view. To add an exception to the report, click on the box next to the exception code to
place a checkmark. To remove an exception from the report, remove the checkmark. Click the
Save button to retain changes.

Exception for, Report E

Select exceptions to print in reports

v El-EarlyIn
w| ED - Early Out
v L0 -Late 0 Vs

Lt

MP - Mizzing Punch
v ABS - Absence
w| LM - Long Meal
v SM - Short Meal

W WS - Mot Scheduled

Note: This sets the default criteria. You must repeat the process to add or remove exceptions.

Hours Summary Report

This report provides a one line total for each employee, displaying pay codes, wages, and total
hours. This can also provide totals by department, when the selected employee is sorted by
department. Wages will only be displayed if enabled to be displayed on reports on the Pay
Code tab from the Setup Wizard.

From the main view, click on the Hours Summary Report icon
report screen will appear:

and the following type of
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Without Wages Example

GI202006 11:29.03 AM
Hours Summary Report

42472006 - 5772006

Departrnent Amount
Pawton, Teffrey 55100 35000 LLER T a0on LR LLER T 00:00 fo:on LR 20:00 "
Grand Totals: ss:oof] | zs:oo] | oowoo] | cocoo] | eowoo] | oowoo] | oooo] | oooofl | co:od] | a0:00]] | a]

With Wages Example

Historical Report

This report displays all of the historical data of an employee for a defined length of time,
including exceptions, absences, and pay code information.

To configure the Historical Report settings, right-click on the Historical Report
following dialog box will be displayed:

=
Start Date: End Date
| 17 172002 =l | 1/31/2002 |
Paycode: ~Exceptian:
Select Paycode(s] Select Exceptiong(s] Display if greater than  Maik if greater than
I REG - Regular [WIEI - Early In 10 [E]mn 10 [Egjmin
COT - Overime [ EO - Early Out R e 10 |eg]n
1072 - Overtime 2 [C1LI-Late In 10 [Fg]min 10 ||
[ 5CK-Sick ] LO - Late Out I 10 el
CIHOL - Holiday 1 WP - Missing Punch
CIWAC-Vacation ] ABS - Absence _ o
[1PER: - Persannal 1Lt - Lang keal [0 Tx]min [io_egrin
[l BER - Bersawement ] SM - Short Meal 0 [Eg]mn 10 [Eg
[1MSC- Miscellaneous [ NS - Mot Scheduled
[~ AllPay Codes I Al Exceptions
Dizplay the number of exceptions per day of weelk?
" No
i+ ‘fes
\;f Save I j='|_ Close |

Select a Start Date and End Date using the dropdown boxes.

2. Select the Pay code(s) and Exceptions (must have at least one exception selected) to be
included in the report. Placing a checkmark next to All Pay Codes or All Exceptions will
include all available Pay codes/Exceptions in the report.

Icon. The
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3. For each Exception selected (excluding Missing Punch, Absence, and Not Scheduled), you
must specify a qualification (in minutes) or mark (underline) for the Exception. If the
Exception is less than the range specified, it will not appear on the report. For example, if an
employee punches in 9 minutes later than the scheduled time, and the Late In (LI) Exception
is set to “Display if greater than” 10 minutes, that Exception will not appear in the report. If
the LI was 10 minutes or greater, it will appear in the report. Likewise, if you set the “Mark if
greater than” 10 minutes, the time will be displayed in the report and underlined in red.

4. Toinclude a tabulated summary of Exceptions for each day of the week, select “Yes” to the
guestion, “Display the number of exceptions per day of week?”.

Click on the Save button to save your settings.
To exit the Historical Report Settings dialog box, click on the Close button.
To run the report, left-click on the Historical Report Icon. A Historical Report will appear on
screen for each selected employee as illustrated by the following example. To print the
report, select the Print command from the File Menu.
Historical Report
Amano
21282003 - 3/3/2003
3/3/2003 04:23 PM
SONG, JOHN Employee Humber 1 Badge Humber 000000001
Feb Sat Sun Mon Tue Ved Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri Sat Sun Mon Tue Wed Thu Fri
2003 1 2 3 4 5 6 7 8 9 10 M 12 13 14 15 16 17 18 19 20 M 2 23 4 % % 2R 2%
REG 19.001 1 |0%:00
7] I0: 05| 1 |00:03
LO M 1 |01:00
Sat Sun Wied Thu S Tue & S 0 Sa Wed Thu Fri Sat Sun Mon #of
1 28 29 30 3 Times
{2 0 3008 0007 30) 3 |2400
] nn:30| 1 |on3o
E0 M| 1 |on3o
Ll rm 1 [o100
Paycode(s) Total
REG
L3z00 |
Exception(s) Total
[ [ o [ u | o |
[on3s | ooao | otoo | ot00 |
Exception{s) Per Day
Mon Tue Wed Thu Fri Sat Sun
=] 1 1
LO 1
EO 1
1] 1
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Chapter 7: Troubleshooting Calculations

When times and/or hours calculated for an employee do not match what you believe to be the
correct total, the first thing that must be taken into account is the Pay Policy that the employee
has been assigned to. To determine the Pay Policy assigned to an employee, right mouse click
on the employee and select Employee from the dropdown list. To view the rules of the Pay
Policy, select the Setup Wizard from the Main menu. Once open, select the “Pay Policy” tab,

and click the Pay Policy con to view the settings. Some of the key areas that impact the
way employee hours are calculated are:

o Overtime Rules
¢ Rounding Rules, including Unit and Point settings
¢ Meal Rules, including Unit and Point settings

In addition, the length of the time assigned for the Meal will impact the way an employee’s
hours are calculated.

It is recommended that you record this information on an Employee Calculation worksheet and
confirm that all rules have been taken into consideration. If the calculations are still not correct,
please refer to the section describing Time Guardian Basic Customer Support.

Time Simulation

The Time Simulation utility can be launched from the Main window by selecting Tools => Time
Simulation submenu selections from the Help Menu as illustrated here:

By entering the Unit and Point assigned to the employee’s Pay Policy, and then entering the
Punch Time for the employee, Time Guardian will display the calculated rounded time when the
“Simulation” button is pressed. As seen in the example below, if the Unit is 15 and the Point is
7, and the employee punches IN at 12:07, then the time will be moved forward to 12:15.

Time Simulation x| Time Simulation x|
Unit Point  Punch Time Round Urit Paint  Punch Time Round
-l [ = [ | [5 =] [ = [z [1z15
Punch Time Time Rounded Punch Time Time Rounded

A ﬂ 45 450 ﬂ B 458 M 45 45+ &l—- 45

30 30 30 a0

yD- 'D' D yDy
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Hours Simulation

The Hours Simulation utility can be launched from the Main window by selecting Tools =>
Hours Simulation submenu selections from the Help Menu as illustrated here:

Select the type of simulation you would like to perform by choosing either "Minutes to
Hundreds" or "Hundreds to Minutes." Next, enter the employee’s time. The calculated time in
Hundreds or Minutes will be displayed when the “Simulation” button is pressed. An example of

each of these calculations is shown here:

Hours Simulation

~Tupe
' Minutes to Hundreds

" Hundreds to Minutes

Enter your hours in minutes |'|2:30

Fiesult in hundreds

1256

Hours Simulation

Tupe

 Minutes to Hundreds
¢ Hundreds to Minutes

Enter your hours in hundreds |12.5

Result in minutes

|12:3I]
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Chapter 8: XML Data Export Utility

The XML Data Export utility can be launched from the Main window by selecting XML Data
submenu selection from the Help Menu as illustrated here:

This utility exports the payroll information of selected employees to the AMANO.XML file, which
is saved in the Time Guardian root directory. The following are examples of the two formats that
the XML file can appear in. The first example is the “Raw data” file format view, while the
second example is the file viewed from a web browser.

Raw Data View Example

<?xml version="1.0"?7>

<! DOCTYPE COMPANY [

<! ELEMENT
<! ELEMENT

CMPCODE (#PCDATA)>
EMPLOYEE (EMPNUMBER, EMPBADGENUMBER, EMPLASTNAME,

EMPMIDDLENAME?, EMPFIRSTNAME , EMPSSN, RATE OF PAY?, PAYCODE*)>

<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT

EMPNUMBER (#PCDATA)>

EMPBADGENUMBER (#PCDATA)>

EMPLASTNAME (4PCDATA)>

EMPMIDDLLENAME (#PCDATA)>

EMPFIRSTNAME (#PCDATA)>

RATE OF PAY (#PCDATA)>

EMPSSN (#PCDATA)>

PAYCODE (PCNAME, PCTYPE, PCDATE, PCVALUE?

PCVALUE _HUNDRED?, PCVALUE MINUTES?, LABOR LEVEL?, ZONE?)>

<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT
<! ELEMENT

PCNAME (4PCDATA)>

PCTYPE (#PCDATA)>

PCDATE (#PCDATA)>

PCVALUE (#PCDATA)>
PCVALUE_HUNDRED (#PCDATA)>
PCVALUE MINUTES (#PCDATA)>
LABOR_LEVEL (LEVEL1?, LEVEL2?, LEVEL3?, LEVEL4?, LEVEL5?)>
LEVEL1 (#PCDATA)>

LEVEL2 (#PCDATA)>

LEVEL3 (#PCDATA)>

LEVEL4 (#PCDATA)>

LEVELS (#PCDATA)>

ZONE (CODE)>

CODE (#PCDATA)>

<! ELEMENT COMPANY ANY>
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Web Browser View Example

<COMPANY>
<CODE> </CODE >
<EMPLOYEE>
<EMPNUMBER> </EMPNUMBER>
<EMPBADGENUMBER> </EMPBADGENUMBER>
<EMPLASTNAME> </EMPLASTNAME>
<EMPMIDDLLENAME> </EMPLASTNAME>
<EMPFIRSTNAME> </EMPLASTNAME>
<EMPRATEOFPAY> </ EMPRATEOFPAY >
<EMPSSN> </EMPSSN>
<PAYCODE>
<PCDATE> </PCDATE>
<PCTYPE> </PCTYPE>
<PCNAME> </PCNAME>
<PCVALUE HUNDRED > </ PCVALUE HUNDRED >
<PCVALUE MINUTES > </ PCVALUE MINUTES >
<PCVALUE > </ PCVALUE >
<LABOR LEVEL>
<LEVELI1> </LEVEL1>
<LEVEL2> </LEVEL2>
<LEVEL3> </LEVEL3>
<LEVEL4> </LEVEL4>
<LEVELS5> </LEVEL5>
</LABOR_LEVEL>
<ZONE>
<CODE> </CODE>
</ZONE>
</PAYCODE>
</EMPLOYEE>
</COMPANY>
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Chapter 9: Quick Steps (QS)

QS 1: Creating a Custom Toolbar

There are two methods to access the Custom Toolbar module:

e The first method is to select the Custom Toolbar sub-menu option from the File menu as
illustrated in the following:

Employee Display Conl

Refresh Data E 4

Backup 3
Upgrade Time Guardian
Prink

Exit

¢ The second method is to right mouse click in the Custom Toolbar section of the Main View
as shown in the following:

"& Time Guardian - Paxton, Jeffrey
File Emploves Display Communication Setup  Grid Display  Help

@ % g g IR [hion 4/24/2006 - Sun 57 < [7 Pay Pariod bet ﬁ

Reparts
=

Custam Toolbar

Next, click on the| button and the following screen will appear:

%] Custom ToolBar |

Available buttons: aK
= |
Commumieation EE Sclect Employes
%
Setup
Help
Reports

To add command buttans, drag and drop buttons onta the Toolbar. To remove
command buttons, drag them off of the ToolE ar.

Left mouse click to select the Custom Toolbar module. There are five categories, which contain
icons: Employee, Communication, Setup, Help, and Reports.

As demonstrated in the figure above, highlighting a category will display the icons currently
available. As stated at the bottom of the custom toolbar box, icons are added and removed
from the toolbar using the drag and drop method. The following are step-by-step instructions for
each of these operations.
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Adding an Icon

© g > w NP

Removing an Icon

Repeat as needed.

Open the Custom Toolbar module.

Select the close button to exit the module.

Left mouse click as you drag the icon to the toolbar.

Drop the icon in the desired location on the toolbar.

Highlight the icon to be added from the “Available buttons” list.

1. Open the Custom Toolbar module.

a > w DN

Repeat as needed.

Left mouse click on the icon to be removed.

Select the OK button to exit the module.

Drag the icon off of the custom toolbar and drop it.

QS 2: Modifying the Employee List Box

By Default, Time Guardian displays all employees entered in the system in the Employee List
box, sorted by Employee Number. However, this information can be filtered and sorted based
on selections made in the Select Employee module and the Sort By menu.

Modifying the Employee List box display:

1. Click on Employee from the main menu, and pull down and click on Select Employees
submenu option from the Employee menu. The following screen will appear:

—Selection Type——————
+ Department

= All Employess

Departments

01 Mo Department

[] 2 Operations Warehouse
[ 3 Delivery

[] 4 Sales

[] 5 Administration

[~ AllDepartrments

Select Employees

Employee List

X

100 Test Emplayes
350457452 Quirez Abel
352805648 Garcia Felicianc
584155175 Xolio Felipe
340702904 Quiroz Horacio
467308963 Flores Humbert:
308313309 Quiroz Joel
367272180 Rueda Joel
333121286 Gil Oscar
3RBE0655T Rodriguez Ram
534672997 Acosta Rolandc
342562514 Catalan Fidel

354822706 Catalan Juan
382905432 Cruz Ruben
345931239 J acinto Santiag
3399644592 Perez Jorge

I00A TN Priadz bdiooal

[~ Al Employees

FEEEEEEEEEEEEEEEENE

354823206 Catalan Flavio __|

-

x LCancel |

2. As seen above, the Selection Type allows you to filter by Department or All Employees.

a. When Department is selected, a list of available departments (user defined) will be
displayed in the Departments list. Once a department is selected, the employees
assigned to that department will be displayed in the Employee List to the right. The
default is to display all employees. To deselect a specific employee, left mouse click to

remove the check mark.

9-2
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b. When the All Employees check box is selected, the Employee List box will display all
existing employees. To remove a specific employee, left mouse click to remove the
check mark alongside that employee.

3. Select the I:I button to save, and exit this screen.

4. This will automatically update the Employee List box.

Sorting Employees in the Employee List Box

The employee list box can be sorted by: Employee Number, Badge Number, Last Name, First
Name, or Department.

1. Right mouse click anywhere in the Employee List to display the dropdown menu.
2. Select the Sort By... option.
3. Highlight the desired field as shown in the figure below.

add Emploves
Delete Employes
Emploves
Department
Schedule

Emplovees Mumber
Badge Mumber
Last Mame

First Marme
Department

4. Left mouse click on the desired sort method to perform the sort and exit.

5. Modify as needed.

QS 3: Adding, Deleting and Modifying Departments

No Departments are required when setting up Time Guardian. To Add, Delete, or Modify a
Department once the software has been installed, follow the steps below:

Adding Departments

Open the Department Module, using either of the two following methods:
1. Inthe 1% method select Setup from the Main Menu, pull down to the Wizard submenu, click

on the Department tab, and then click on icon and the Department screen shown
below will appear.

2. In the 2™ method; right click in the Employee List from the main view and select Department
from the dropdown list. The following Department: screen will be displayed. Select the New

]

icon to add a Department.

3. Enter the required fields:

¢ Number: A mandatory field that can only contain numeric values.
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¢ Name: A mandatory field that will be displayed throughout the program to describe the

Department.

Department : Mo Department il
SlE|X]ol =
. Operations Fillet
Marne: ||N0 D epartment | Operations ‘Warehouge
Delivery
Comments: Salex
;I Admiristration

4. Enter Comments (Optional).

5. Select the Save

6. Select the Close

icon to save changes.

B

icon to close the Department module.

Deleting Departments

1. Open the Department Module by using either of the two following methods:

a. 1% method: Select Setup from the Main Menu, pull down to the Wizard submenu, click

on the Department tab, and then click on icon.

b. 2" method: Right click in the Employee List and select Department from the dropdown

list.

2. Highlight the Department to be deleted from the Department List.

Select the Delete

X

icon.

A confirmation box will be displayed.

Select Yes to continue, No to return to the Department module.

6. Select the Close

B

icon to close module.

Modifying Departments

Departments are modified using the same steps for adding a Department.
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QS 4: Adding, Deleting & Modifying Time Guardian Backup Schedule

A Backup schedule can be created when the software is first installed, or by adding it later by
following the steps below.

Adding a Backup Schedule

1. Open the Backup module by using either of the two following methods:

a. 1% method: Select Setup from the Main Menu, pull down to the Wizard submenu, click
on the Login tab.

B
b. 2" method: Click the Wizard I— icon located on the Custom Toolbar, and click on the
Login tab.

2. Select Yes to the question “Do you want to create an automatic backup schedule?” and the

Backup icon will become active. Click on the Backup i) jcon and the following screen will

appear:

Backup Information @

Select the day of the week ta start your backup

Monday A

“What is the number of histaric backup files to be created?
1 =

Backup file location
|C “Program Files\Time Guardian‘Backup g

' \/ Save | x Cancel |

Select the day that you would like to start the Backup from the dropdown menu.
Enter the number of historic Backup files to be created and rotated (1 — 25).

Enter the Backup location by browsing to where you want it stored.

o o k& w

Click on the L A button to save backup settings, and exit the module.

Deleting a Backup Schedule

1. Open the Login tab (see above).

2. To cancel the Backup entirely, select “No” to the question “Do you want to create an
automatic backup schedule?”

3. Click the to finish no backup selection, and exit the Wizard.

Modifying a Backup Schedule

1. Open the Backup module (see above).

2. Select Yes to the question “Do you want to create an automatic backup schedule?”

3. To modify the start day of the Backup, click on the dropdown arrow and select a new day.
4

To modify the number of Backup files to be created (1 — 25), enter the modified number.

5. Click the - button to save new backup settings, and exit the backup module.
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QS 5: Adding, Deleting and Modifying Login Profiles

A Login Profile must be created before the setup Wizard is complete. To add, delete or modify
a Login Profile once the software has been installed, see the following steps. The following is
an example of the Login/Profile screens that will be displayed:

Add New Profile X
User Prafile ] Avanced Password |
Marne: ’l—
Passward:
Confirm Password:
Language: English -
[ Administrator [~ Read Only

Adding a Login Profile

1.

N o g s w D

Open the Login Profile module. This can be done by using either of the three following
methods:

d. 1% method: Selecting Setup from the Main Menu, and clicking the Login Profiles
submenu.

e. 2" method: Selecting Setup from the Main Menu, and clicking the Wizard submenu.
From the Setup Wizard screen click the Login tab, and then click on the Login

Information button and the above Login Profile screen on the left will appear.

b
f. 3" method: Clicking on the Wizard =1 icon in the Custom Toolbar to display the Setup
Wizard screen, selecting the Login tab, and then clicking on the Login Information

button and the above Login Profile screen on the left will appear.

From the Login Profile screen (as illustrated above) click on the button.

Enter the Name of the user (see screen above on right).

Enter and confirm the password.

Select Language from drop down menu.

Select if the user will have Administrator or Read Only Access.

Select the Advanced Password Tab and the following screen will appear to choose
password expiration options.
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8. Select the L 2 button to save, and exit. Repeat procedure as needed.

2& To set the Default User, highlight the Profile from the “Authorized Profile List” and check the
Default User box.

9. Select 1 Cios= button to exit the Login Profile module.

Deleting a Login Profile

1. Open the Login Profile module (see above).
2. Highlight the User in the “Authorized Profile List.”

Bemaove

3. Select| " button to delete the user.

4. A confirmation box will be displayed. Select Yes to remove the profile, or No to return to the
Login Profile module.

5. Select Close button to exit the Login Profile module.

Modifying a Login Profile

1. Open the Login Profile module (see above).
2. Highlight the User in the “Authorized Profile List.”

3. Change the user password by selecting button and entering the Old and

New Password (see following example of the Change password view). Click the

| button to return back to the Login Profile screen.

T
Employes Il—
Old Password ||—
Mew Paszsword I—

e Gaye I X Cancel |

4. From the Login Profile screen, modify the Default User by selecting or deselecting the
check box.

5. CIickl J1 Close " button to exit the Login Profile module.

Changing the Language of a Login Profile

1. Open the Login Profile module (see above).
2. Highlight the desired user in the “Authorized Profile List.”

Change Language

3. Select the| | button and the following screen will appear:
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4. Select the desired language from the “Language” dropdown list (See above example).

5. Click the L | button to save, and return back to the Login Profile module screen as
illustrated in the following:

QS 6: Adding, Deleting and Modifying Schedules

No schedules are required when setting up Time Guardian. However, an employee designated
in the type of employee as “Salary” during the Employee setup must have an assigned
schedule before hours are awarded. To Add, Delete, or Modify a Schedule once the software

has been installed, follow the steps below. The following is an example of the Schedule setup
module:

o|@ 8 x]=] =

Mame: Son-Zoff-Bam-Spm

S Does this schedule crass midnight?

Mon) " Heg Mo
,7 Start

08:00 &M

" Previous Day
& Curent Day
End

|05 00 PR

AL YA VLYY
ooz
SETTERS

!
oE ow
gE
E]
@
-8

& Current Day
" MextDay

oK Cancel

Adding Employee Schedules

1. Open the Schedule setup module. This can be done by using either of the three following
methods:

a. 1% method: Right clicking in the Employee List and selecting Schedule from the
dropdown menu.

b. 2" method: Selecting Setup from the Main menu, and click on the Wizard submenu.
From the Setup Wizard screen, select the Schedule tab, and click on the Schedule

Information El button.

Time Guardian v4.0 User's Guide



c. 3“method: Selecting the Wizard == icon located on the Custom Toolbar, and
choosing the Schedule tab.

]

From the Schedule screen (see above), click on the New icon to begin.

Enter the Schedule Name and press enter or tab.
Select Yes or No to the question “Does the schedule cross midnight?”

Select the schedule days.

o g > w DN

Enter the Start and End time (schedules that cross midnight will need a Previous, Current,
or Next indicator).

7. Click the to save the times. (The Schedule will now be displayed in the Schedule
Preview.)

&=

icon to exit the module.

8. Repeat as needed, or select the

Deleting Employee Schedules

1. Open the Schedule module (see above).
2. Highlight the schedule to be deleted from the schedule list box.

X

3. Select the Delete icon to remove schedule.

&=

4. Repeat as needed or select the Close icon to exit the module.

2% If the delete icon is not available, an employee is assigned to that schedule and Time
Guardian will not allow you to remove the schedule while an employee is assigned to it.

Modifying Employee Schedules:

1. Open the Schedule module (see above).
2. Highlight the schedule to be modified from the schedule list box.

3. Select the Edit icon.

4. Enter maodifications (Start Time, End Time or Days). If no modifications are desired click on

the button to exit.

X This option is also used when a schedule has multiple start and/or end times.

5. Select button to save the modified times. (Schedule will now be displayed in the
Schedule Preview.)

E

6. Repeat as needed, or select the Close icon to exit the Schedule module and return to

the Setup Wizard screen.
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QS 7: Printing Time Guardian Documentation

To print additional copies of the User’s Guide, or Worksheet, follow these steps:

1. From the Main Menu, select Help, pull down to select Help F1 submenu, and the following
screen will appear:

2. Highlight the document (and/or section) to be printed: User Guide, or Worksheet.

3. Click on the button, and a print box will appear prompting you to select the
desired printer. Repeat as needed.

2% Use the Index and/or Find tabs to search through the on-line documentation.

QS 8: Creating, Deleting, Modifying, Assigning & Downloading Door
Access & Bell Schedules

Door Access and Bell Schedules are not required when setting up Time Guardian. To Create,
Modify or Assign a schedule once the software has been installed, follow the steps below.
Below is an example of the Relay Event Setting screens. The screen to the left is for Door
Access and the screen to the right is for Bell Schedules.

Relay Schedule x|
of & =
Fielay Event Setting | Bssign Rielay Sehedule
Fielay Schedule List

" Daor
&+ Bell

—Fielay Evant
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Creating Relay Schedules

1.

S e

Open the Relay Schedule module. This can be done by using either of the two following
methods:

a. 1% method: Selecting Setup from the Main menu, and click on the Wizard submenu.
From the Setup Wizard screen, select the Clock tab.

B

b. 2" method: Selecting the Wizard icon located on the Custom Toolbar, and
choosing the Clock tab. The following screen will appear:

Select Yes to the question “Do you want to download a schedule to ring bells?” and click the

Bell icon and the following Relay Schedule screen will appear:
o @ x| =
Fielay Event Setting ] Aszigh Relay Schedule ]

& Door

" Bel

Felay Duration 00:1g

Enter the Relay Schedule Name.
Select the type of schedule, Door or Bell.
If Door is selected, enter the Relay Duration time.

If Bell is selected, enter the Duration, Time, and days as illustrated in the following example.
To enter this information, double-click in the highlighted row and/or click on the Insert

button. To modify previously entered Relay Event Setting, click on the desired event

in the Relay Schedule List, and click the Edit button.
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Relay Schedule

o] & x|

Relay Event Setting

Name  ||Moon-unch-break.

" Door
™ Bell

Relay Event
Duration Time

0015

=

Azzign Relay Schedule ]

Relay Schedule List

MNoor-unch-break.

Mon Tue “Wed Thu Fi Sat Sun

1200PM  Ring Ring Ring Ring Ring

Inzert

7. Enter Relay Schedule information in the Relay Event as illustrated in the following example.
Click the Apply icon to save the relay event.

i ]
0| u| X] =
Relay Event Setting I ]
= elay Schedule List
Hame & Relay Event E oon-unch-break.
 Dowr Duration |00:15
&+ Bell Time
Relay Event Day
Duration Sat Sun
[ Selectal
e X oo e |

8. Select the New B

&=

9. Repeat as needed, or select the
the Setup Wizard.

Deleting Relay Schedules

icon to create additional schedules as needed.

icon to exit the Relay Schedule module, and return to

1. Open the Relay Schedule module (see above).

2. Highlight the schedule to be deleted from the Relay Schedule List box.

X

3. Select the Delete

Repeat as needed, or select the Close
return to the Setup Wizard.

Modifying Relay Schedules

E

icon to remove relay schedule.

icon to exit the Relay Schedule module, and

1. Open the Relay Schedule module (see above).

9-12
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2. Highlight the relay schedule to be modified from the Relay Schedule List box.

3. Select the button, and make the desired modification and repeat as needed.

4. Click Save =

icon to save the modified relay schedule.

Assigning Relay Schedules To The Terminal

1. Open the Relay Schedule module (see above).

2. Highlight the Assign Relay Schedule tab (see example below).

3. Highlight the Relay Schedule from the Relay Name List.

4. Click the Assign icon. The Relay Schedule will appear below the terminal number under the
Terminal Number List.

20X When using multiple terminals, you must first highlight the desired terminal number before
clicking the Assign icon. This will ensure that the correct relay schedule has been

assigned.

5. Repeat as needed.

6. Click the Save

icon to exit the module.
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Downloading Relay Schedules

1. Select Communication from the Main Menu.
2. Select Downloading or Auto Update from the dropdown menu.

2k Both of these options will automatically establish communications with the terminal and
download all relay schedules currently assigned to a clock.

2°X This step can be repeated at will. If the clock is set to auto poll and time sync, this operation
will be performed automatically each time the software is opened.

QS 9: Using On-line Help

To use the Time Guardian on-line help feature, follow the steps below.

Note: You can select On-line popup help for the Setup Wizard at any time, by clicking on the

button on the Setup Wizard screen.
1. Open the Help module. This can be done by using either of the two following methods:

a. 1% method: Selecting Help from the Main menu, and click on the Help F1 submenu.

Q

Topics screen, click on the in the top toolbar for balloon help. The following screen
is an example of the Help Topics Contents tab view:

icon located on the Custom Toolbar. From the Help

b. 2" method: Selecting the HI%'

2. Click on a book, and then click on the button to view the contents of that book.

From the Contents tab view, select desired section, and click on the button to
launch the text view of selection (see following example). Use the following toolbar
Back | Print | 11 | 3 I

navigation tools to move through book contents => [ Heln Topics|
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<> Time Guardian Help

File Edit Bookmark Options Help
Help Tapics Back Print < 2>
Adding Employees
A
Selecting this option wil display the screens below:
Employee (Briseno,Alex) x|
blEx|-lp] =
Gereral | Personal | 5ol Fay | Employee List
Last Mame Type of Employes Acanion. Lanence
[Heuy ] | Aot Rolanda
Middle Name Depattment lmanzaHiguel
| Operations warshouse x|
First Mame Schedule
e night - Castilla, Hector
I . J Castilla Rodriguez Wincente
Employes humber Pay Policy Catalan Fidel
561730851 Pay Policy #1 x| | |Catalan.Flavia
u—l I Y Y J Catalan Juan
Eadge Mumber Hire Date: Catic,Samir
000000003 B/ 6/2001 =] [ |Chorstie Darisle
I——I I J Chiamo.Susan
Inactive Date Holiday Eligibility D ate Clark Michael
= <1 | |Conea Eleazar
| 47 172002 = [ 97 sezom I [} | e
I Inactive I~ Mot Eligible for Holidays Cridler,Cathryn ;I
The Employes Information module consists of three tabs: General, Personal and Salary Pay. Below is an
overview of each of these tabs including field names and definitions. The fields outlined in red are
mandatory and na record can he saved without the proper information being ertered. Time Guardian can
easily arcommodate emplovees with the same first or last name, however the Employes Number must be
unigue since it is the primary sorting key. Badoe Mumbers can be changed or reused should an employes
loze the badge or become inactive. Each tab also has an Employes List; double clicking & selected
employes on this list will causs their information to become active in all fislds: b

3. Click on the Index tab (see example below) to view contents of selected book. Click on the

Find tab to search book contents (see example below). From Index or Find tab view,

highlight selected content, and click on the button to display help text in pop-up

window (see above example).

| Help Topics: Time Guardian Help E|g|

Eontentsllndek Find I

1 Type the word(s] you want ta find

|disp j Clear
-]

2 Select some matching words ta narow your zeaich

Optionz..
[[Fdsuds.. |
T
J Frebuild..

3 Click a topic, then click Display

[_] Addina, Editing and Deleting Emplayes Punches

[ ] Advanced Overtime

[] Assigning Reasons to Exception Flags

1 CBS Papral

[ Changing the Grid Wigw

[ Communication Settings j

|ED Topicz Found | | All words, Begin, Auto, Pause |

Display | | Cancel |

4. Use the menu and submenu selections from the Time Guardian Help main view for
advanced help functions. The menus consist of:

e File:

— Open: This menu selection opens the current help topic selection in a separate
window.

— Print Topic: This menu selection prints the open help topic window..

— Exit: This menu selection allows you to exit and close help window.
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e Edit:

— Copy: The menu selection allows you copy and highlighted help text to the
clipboard.

— Annotate...: This menu selection allows you to create and store text annotations for
help selections in a separate window.

e Bookmark:
— Define...: This menu selection allows you to define Bookmarks.
e Options: This menu selection contains the following submenu selections:

— Keep Help on Top: This menu selection allows you to configure Help display
window to be: Default, On Top, or Not on Top.

— Display History Window: This menu selection allows you to display in separate
window, historical listing of all selections. Can use this navigate selections.

— Font: This menu selection allows you to view help text in Small, Normal, or Large
font size.

— Use System Colors: Change system colors.
e Help:
— Version: This menu selection allows you to view version of Microsoft Windows Help.
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Chapter 10: Glossary and Vocabulary

100 of hours

Displays hours in the software in decimal format. Example: 8 hours, 15 minutes will be
displayed as 8.25 hours.

About

Displays the version of the software and the Serial Number of the package.

ABS Absence
When an employee is scheduled to work on a day and does not appear.

Add Employee
Adds new employees to Time Guardian.

Advanced Settings
Allows the user to set a specific Day Change Time and Override.

After Midnight

The Day Change Time set in the software occurs on or after midnight. Example: a Day Change
Time of 1:00 a.m. occurs after midnight.

AM/PM
Used to indicate day or night when using a 12 hour format for displaying time.

Audit Report

A report that displays all changes made in Time Guardian, which is listed by user, date, time,
and the change made.

Auto Update
Automatically locates the terminal and sets the time.

Badge Number

The number of the card assigned to each employee.

Before Midnight

The Day Change Time set in the software occurs on or before midnight. Example: a Day
Change Time of 10:00 p.m. occurs before midnight.
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Bell

One of two types of relay schedules, a bell is a device used to produce a tone at an assigned
time and day.

Bereavement

The Pay Code used for grievance.

Bonus

Used to give an employee a monetary award for a given day.

By Actual Time
Displays actual punch times in the editing screen.

By Rounded Time
Displays Rounded punches (configured by the pay policy) in the editing screen.

Clear Transaction
Will clear all punches recorded in the terminal.

Comments

Used to add text to describe certain areas (for reference only).

Current

Indicates the “Current” day.

Custom Toolbar

Allows the user to add, edit or delete buttons from the toolbar located on the Main screen.

Daily Overtime

The time at which hours worked are applied to the Overtime Pay Code.

Daily Rounding

Used to round an employee’s recorded punches based on a defined Unit and Point in the Pay
Policy.

Day Change Time

The time at which the next work day begins. By default, this setting is 2:00 a.m.
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Department Report
Provides data based on the Department that the employee is assigned to.

Departments
Used to group employees for reporting purposes only.

DOB
Abbreviation used for Date of Birth.

Dollar Pay Codes
Used to assign Tips and Bonuses in the system.

Door

One of two types of relay schedules, Door is used to assign the duration of time when access is
permitted.

Duration
Used to specify the amount of time for a Relay Schedule.

El Early IN

An exception used to identify early IN punches for an employee.

Employee Number

The unique number assigned to each employee.

Employee Report

Provides a list of all employees in the system.

Employee Setup
An option located on the Main menu that allows the administration of employees in the system.

Early Out (EO)

An exception used to identify early OUT punches for an employee.

Example Simulation

A tool that tests the results of certain rounding rules.
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Exception Codes

Flags used to track employee schedule deviations.

Exception Report
A report used to track deviations.

Grid View
Allows you to select the way in which you would like to view the employee data.

Hire Date
The first date that an employee begins working for an employer.

Historical Report

This report displays all historical data for an employee for a given length of time, including
absence, exception, and pay code information.

Holiday
An assigned day off.

Holidays

Located under the Pay Codes setup, this menu allows holidays to be assigned a pay code and
the number of hours to be paid.

Hourly
One of two types of employee designations used by Time Guardian when calculating time.

Hours Display

Determines how hours are displayed throughout the system. There are two options: Minutes
and 100 of hours.

Hours Grid

Displays a complete history of employee activity for a given date range.

Hours Worked Report

Displays a complete history of hours worked by date and employee range.
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Import

Extracting data from third party software and adding it to Time Guardian.

Inactive Date
The date on which an employee’s hours are no longer calculated by the system.

Initialize
Used in conjunction with the terminal to establish communication.
Late In (LI)

An exception used to identify late IN punches for an employee.

Long Meal (LM)

An exception used to identify a long meal by an employee.

Late Out (LO)
An exception used to identify late OUT punches for an employee.

Login Profile

Used to indicate an assigned Username and Password to provide access to the software.

Meal
A designated period of break time for an employee.

Maximum Shift Length

Determines the period of time that all punches occurring after Day Change Time will be
associated with the last IN Punch before the Day Change Time.

Meal Grace

A "Free" period of time that is allocated to an employee who returns late from a meal.

Memory Dump

A command sent to the terminal that will erase all data currently stored in its memory.

Military Time

Based on a 24-hour clock, military time is one of two standard forms of recording time.
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Miscellaneous
Used to denote information that falls into no specific category.

Missing Punch (MP)
An exception used to identify missing punches for an employee.

Next
Indicating that the punch occurred after midnight and is applied to the “Next” day.

No Schedule
Indicates that no specific schedule has been assigned to an employee.

Not Scheduled (NS)

An exception used to identify an employee who works on a day where they have no assigned
schedule.

On-Line
Used in the Help menu, on-line indicates that the information is contained within the software.

Overtime

Hours worked that extend beyond an assigned schedule.

Overtime Authorization

Requires manager approval before overtime hours are awarded.

Overtime Reset Day

The day or date on which overtime calculations are reset.

Pay Policy
The rules used to calculate employee hours.

Pay Codes

Used to allocate employees’ worked and non-worked hours. There are nine (9) predefined Pay
Codes.
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Pay Code Multiplier

Used to provide a multiplier for employees’ worked hours from a specific date. There are nine
(9) predefined Pay Codes. The multiplier can also be increased by a percentage from a specific
date.

Pay Period

The interval by which an employee is paid. Industry standards are weekly, bi-weekly, semi-
monthly and monthly.

Payroll Interface
Payroll software packages that Time Guardian can automatically interact with.

Personal

Part of the employee profile. This section is used to record information such as address, phone,
DOB and more.

Point

Used in rounding calculations, the point is the place at which the punched time will be moved
forward to the next “Unit.”

Poll
A term used to describe the retrieving of information from the terminal by the software.

Presence Report
A report that displays employees currently punched IN at the terminal.

Previous
Indicates that the punch originates from the “Previous” day.

Profile

Used throughout the software to indicate a summary of information.

Refresh Data

Located under the “File” section of the Main menu, this option is used to update the software
with the most recent information available.

Regular

The most common Pay Code used to identify hours worked by an employee.
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Relay

A circuit located on the terminal that will allow for controlled door access or the ringing of bells
at assigned times and days.

Relay Name List

A list of available schedules that may be assigned to a terminal, and only one schedule can be
assigned per terminal.

Report
A format for presenting employee and system information to the user in a predefined format.

Rounding
A formula used to adjust employees’ punched time based on a defined Unit and Point.

Rounding Rules
The specific Unit and Point that determines how employee’s punches will be rounded.

Salary

One of two types of employee designations used by Time Guardian. Employees who are
salaried do not to have to punch in, but they must have an assigned schedule. If a salaried
employee works on a holiday, they will only receive holiday pay.

Save

Used to store updates made to the system.

Schedules

Work patterns with fixed start and end times that can then be assigned to employees to track IN
and OUT punches.

Sick

The Pay Code used for employee illness.

Short Meal (SM)

An exception used to identify a short meal.

SS#
The abbreviation used for the Social Security Number.
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TG
An abbreviation for the words "Time Guardian."

Terminal Number List
A listing of all terminals currently available in Time Guardian. Used to assign Relay Schedules.

Time Display
The format used to display time, either AM/PM or Military Time.

Time from Start of Schedule

A setting used when employees are punching IN and OUT for meals. This number defines the
window of time before a meal can be taken.

Tips
Used to record tip earnings. Also, one of two pay codes used to assign dollar amounts.

Tools

Located under the Help section of the Main menu, Tools are internal utilities used to assist in
the understanding of Time Guardian calculations.

Type of Employee

Used to indicate how employee hours will be displayed in Time Guardian. The options are:
Hourly or Salary.

Undefined Data

Data that cannot be processed by Time Guardian will be noted in the Audit Trail Report.
Undefined data is usually caused when an employee is punching prior to being entered in the
software. Time Guardian will automatically process undefined data.

Unit

Identifies how an hour will be divided into smaller pieces for rounding purposes.

Vacation

The Pay Code used for scheduled time off.
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Wages

An assigned dollar amount per hour which is applied to the hours worked plus any authorized
overtime (with pay code multiplier), tips and/or bonuses to create an employee’s calculated
earnings.

Weekly Overtime

An assigned number of hours that, when exceeded, will cause an employee’s hours to be
calculated as overtime.

Wizard

The installation program created specifically for Time Guardian, which can also be accessed
from the Setup menu.
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